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IMPORTANT NOTE: For Cloud deployments please contact your application management team as the
deployment procedure for Cap Cloud is different.
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1 Introduction to Bloomberg Connect

Bloomberg Connect is Calypso’s integration of the Bloomberg Data License. This facility allows one to request per-
security data from the Bloomberg database of the Bloomberg-defined field types: Security Master (security
indicative data), Historical Time Series Data, Derived Data, and End-of-Day Prices. The request to and reply from
Bloomberg are handled via an FTP / SFTP Transfer process. Depending upon the specific information requested
and the functions used, Calypso will take the information requested and create the following:

e A denovo bond product with all indicative information and cashflows

e A de novo equity product with a volatility surface and historical dividends

e A de novo equity index product with a volatility surface and historical dividends

e Anupdate to the indicative information and cashflows of a bond resident in your Calypso database
e An update restricted to only the cashflows of a bond resident in your Calypso database

e Anupdate to the indicative information for an equity or equity index product

e Quotes for a bond, an equity or an equity index may be imported when the indicative information is imported to
form a product. In addition, quotes alone may be imported for bonds, equities, equity indices, rate indices,
currencies, money markets, and commodities

e Certain corporate actions for equities resident in your Calypso database

This functionality allows the transfer of voluminous terms and conditions (e.g., security identifiers, issuer name,
issue date, payment dates, payment frequency, coupon, call schedule, amortization schedule, etc.) and events
(e.g., cashflows, amortization amounts, dividends, stock splits, mergers, price quotes, etc.) from the Bloomberg
database to your Calypso database in a flexible, timely, and automated manner. Requests for information may be
on an ad hoc basis, they may be scheduled via a Calypso Scheduled Task, or the request may be formulated to be
recurring and placed on the Bloomberg server. With this information in the Calypso database, the user may
calculate current valuations, process actual cashflows, forecast future cashflows, process dividends, and other
equity corporate actions, etc.

Calypso supports online immediate requests for individual security information as well as the ability to schedule a
recurring request. One may also use the Bloomberg Connect Window to build a list of requests to be sent to
Bloomberg in one consolidated request. To facilitate a list of requests, a file of security identifiers may be imported
into the Bloomberg Connect Window. Bloomberg Connect combines the security identification information that the
user supplies along with a pre-defined, configurable list of Bloomberg data fields and forms what is known in
Bloomberg jargon as a Request File (the file extension is “. reqg”). The Request File contains information that
identifies the Bloomberg customer, the type of request, the time to run, a list of requested data items (not
necessary for some requests), and a list of securities. The Request File is sent through an FTP / SFTP Transfer to
the Bloomberg server. Bloomberg responds with an encrypted Reply File (the file extension is “out.enc”). The
Calypso Bloomberg engine decrypts the encrypted file, producing a Reply File with a “. out” extension. The
decrypted Reply File repeats the list of requested data field names along with the values of the data fields for the
securities listed. Calypso receives the data and, depending on the functions used, creates a security product or an
update to security information. The mapping from Bloomberg data to Calypso data can be made with a user-
defined product template, a default product template, a user-configurable value mapping, or a hard-coded
mapping created by Calypso.

August 2024 Revision 68.0 / Approved Page 10 /128
Private and Confidential



Nasdaqg Calypso
l’lNanaq Bloomberg DL Products Integration Guide / Version 12.17.0

P See Setting Bloomberg Mapping Values for details on the mapping process.

There are essentially two kinds of timed requests that may be made through the Calypso Bloomberg Connect to
the Bloomberg Data License. These are either requests that are to be run one time only, immediately or at a
scheduled time, or recurring scheduled requests. Bloomberg labels the one time only request as a “oneshot” for
non-master data accounts and “adhoc” for master data accounts. Scheduled requests may be scheduled for a
frequency of daily, weekly, monthly, weekdays or weekends.

Bloomberg refers to the types of requests as “Programs” or “Program Names” Calypso supports the following
Bloomberg programs:

e Getdata — Used for Security Master (security indicative data), Historical Time Series Data, Derived Data and
End of Day Prices.

o Gethistory — Used to retrieve historical data fields within a date range.

e Getactions — Used to obtain Equity Corporate Actions.

e Getsnap — Used to retrieve current and past snapshot pricing.

e Cancel - Used to cancel a request that has been scheduled on the Bloomberg server.

The Calypso Task Station monitors the events when a Request File is sent to Bloomberg, and a reply is

subsequently received. A successful creation or an update of security information in your Calypso database is

reported in the Task Station. It is important to monitor the Task Station for Bloomberg Connect events for the

possibility of error conditions. If Bloomberg returns any errors in the Reply File, then these error codes are also
raised as exceptions on the Task Station.

This guide provides instructions on integrating Calypso with Bloomberg: product integration (bonds and equities),
market data, and trade integration.

CapCloud Clients

System level installation and configuration of Bloomberg is performed by Calypso. Calypso configures the
environment properties according to the requirements of your Bloomberg Implementation.

August 2024 Revision 68.0 / Approved Page 11/128
Private and Confidential



Nasdaqg Calypso
I'INanaq Bloomberg DL Products Integration Guide / Version 12.17.0

2 General Installation

This section applies only to Bloomberg Static Data and Bloomberg Trades.

Bloomberg Static Data and Bloomberg Trades are installed as part of the Calypso Installer when you select the
“Bloomberg Data License” interface:

2 Setup - Calypso 14.0.0.19.5P2-5SNAPSHOT

Select Components

hich corponents should be installed?

Select the components you want toinstall; clear the components vou do not want to install. Click Mext

— & Base Installation (software required Far all installations, inchides Main Enkey)
[ uﬂ Solutions (pre-packaged options Faor installing standard configurations)

EI J] 7] Interfaces {Please consult with your Calypso Account Executive for lcensing questions)

- & Bloomberg Data License

|

P Please refer to the Calypso Installation Guide for complete details on the Calypso Installer.

If you are installing a Calypso Upgrade package instead, the instructions are also in the Calypso Installation Guide.

Database Upgrade

When you run Execute SQL as part of your installation, the Bloomberg files will be already loaded. You just need to
check the “Bloomberg” and “BloombergFeed” checkboxes.
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3 Bloomberg Product Integration

Bloomberg Product integration allows Calypso users to retrieve Bloomberg data from the Bloomberg engine via
Bloomberg Connect using the Calypso Scheduled Tasks window. You can monitor the status via Bloomberg events.

The integration currently supports generating Bloomberg request files to import Bond and Equity product data.
The following steps are required to integrate Bloomberg data into Calypso:

» Add Bloomberg encryption settings (if required).

»  Configure the Bloomberg engine.

»  Configure Calypso environment properties.

»  Review the use of the Bloomberg Private Placement application.

»  Create a batch file to launch the Bloomberg Connect application, or add it to the Calypso Navigator.

» Add the Bloomberg Cash Flow window to the Calypso Navigator.

»  Configure Bond Templates for Bloomberg.

»  Define the ZZ ISO Country Code in Calypso.

» Add and map issuers in Calypso.

»  Configure Bloomberg mappings.

»  Create Calypso Product Codes.

»  Define Calypso Bond Subtypes.

Additionally, you must define various Bloomberg updates for use in Calypso and use the Task Station to create
scheduled tasks for these updates.

The steps are described below.

3.1 Setup Requirements

3.1.1 Specifying the Bloomberg Encryption Utility Location

Ensure that “bbdl/des.exe” is installed on your machine. This application is part of the Data License Request
Builder provided by Bloomberg.

Specify the application’s installation location in the Calypso environment property BLOOMBERG_ENCRYPT_APP.

[NOTE: Bloomberg requires that you use their encryption application. You cannot use another
application.]
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3.1.2 Bloomberg Engine Configuration

The Bloomberg engine is configured in the Engine Manager of Web Admin: event subscription and engine
parameters.

You may need to add this engine if it is not available for configuration: Create a new engine called
BloombergEngine with class name com.calypso.engine.bloomberg.BloombergEngine.

It subscribes to the following events: PSEventBloomberg.

P Please refer to Calypso Web Admin documentation for complete details.

3.1.3 Connection Setup
Calypso supports FTP, FTPS (FTP over SSL), and SFTP (FTP via SSH).

You can select the connection type in the environment property BLOOMBERG_FTP_TYPE. It can be set to FTP,
SFTP, or FTPS. If it is not set, the connection defaults to FTP.

P See Setting Environment Properties for additional settings.
FTPS

FTPS requires that any firewalls between the client and the server allow the connection. Your Network
Administrator must add at least two rules for each firewall: One that permits the control connection and one that
permits the (passive) data connection. Other rules may be required according to comply with your organization’s
internal policy (logging, etc.).

The table below lists the required connections to bfmrr-ssl.bloomberg.com:

Connection Port Protocol
Control 990 TCP
Data 10000- TCP
30000
SFTP

Version 4.6.1 of “edtftpj-pro.jar”is required.

314 Access Permissions
The following access permission function must be granted.

AccessBloombergConnect — Permission to access the Bloomberg Connect window and to view and modify
Bloomberg Connect configurations.

ViewOnlyBloombergMapping — Permission to offers the same capabilities as the AccessBloombergConnect
permission, but with the distinction that it allows users to view the Bloomberg Mapping Window but restricts them
from making any modifications.
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From Calypso Navigator, select Configuration > User Access Control > Access Permissions, and select the Group
Access panel.

»

»

»

Set the following environment properties as applicable.

Groups - Group Access | Book Access l Workflow Access I Data Segregation?

v [ Duplicate ... ]

Group Name  @london

. Access -

; m r Functions

[#- . MirrorBook

[ | Books [

4 Add Readjwrite ]

[#- | . Book Attributes
“-Mirror Book Attr

8 5dd Read Only I

Select a user group from the Group Name drop down, then select the 'Functions' label.

Click Add Read/Write to add access permissions functions as needed.

Then click Save to save the changes.

[NOTE: Access permission functions are defined in the “function” domain.]

3.1.5 Environment Properties

Environment Property Description

BLOOMBERG_ACCOUNT_NAME

BLOOMBERG_ACCOUNT_TYPE

BLOOMBERG_BYPASS_SECURITY_AUTHORIZATION

BLOOMBERG_BYPASS_QUOTE_AUTHORIZATION

FIRMNAME for Getsnap if BLOOMBERG_FTP_USER is
already used.

See also Feed Configuration if you are using multiple
user accounts.

It should be set to "master" for a master data account.
When set to “master”, the Bloomberg Connect requests
become “adhoc” requests. When using Bloomberg
Update, you can set the program flag to “adhoc” or

“oneshot”. “oneshot” requests must be sent 15 minutes
prior to processing.

If not set, “adhoc” requests are not supported, and
“oneshot” requests correspond to one-off requests.
Set to true to bypass authorization for Bond, Equity and
Equity Index securities.

Authorization of securities will be required otherwise.

Set to true to bypass authorization of quotes for the
securities.
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Environment Property Description

Authorization of quotes will be required otherwise.

BLOOMBERG_CALL_PUT_SCHEDULE True or False. Default is False.

If set to true, Calypso saves call/put schedules when
importing the bond.

BLOOMBERG_CREATE_ISSUER True or False. Default is False.

When True, first Calypso verifies if the short name of LE
matches the ISSUER field in the output file, then
proceeds to iterate through Bloomberg, TICKER,
TICKER_1, TICKER_2, TICKER_3, and TICKER_4, and if
Calypso cannot find a matching Legal Entity, the
application then creates a new Legal Entity on-the-fly (of
role Issuer), based on the Bloomberg ISSUER field and
the associated country. The Legal Entity is created with
the status “Enabled” and the exception is placed in the
Task Station.

When False, if a pre-existing issuer is not found, the
application creates the bond using
BLOOMBERG_DUMMY_ISSUER as the short name. In
addition, an exception is raised in the Task Station.

BLOOMBERG_DEFAULT_CLEAN_OR_DIRTY_PRICE_O | (Optional) Default quote value. For example, “100”.

N_CREATION . .

If neither property is set, Calypso does not use a default
BLOOMBERG_DEFAULT_DISCOUNT_OR_YIELD_ON_ | value for the close value on the quote created when
CREATION creating the bond.

If the bond has a quote type of CLEAN_PRICE and there
is no value for QUOTE_MID, Calypso sets the default
value as follows:

BLOOMBERG_CLEAN_OR_DIRTY_PRICE_ON_CREATION /
100

If the bond has a quote type of Yield or Discount and
there is no value for QUOTE_MID, Calypso sets the
default value to as follows:

BLOOMBERG_DEFAULT_DISCOUNT_OR_YEILD_ON_CRE
ATION /100

These two environment properties are only relevant for
bonds. This is a means to set the CLOSE value when
QUOTE_MID is missing or it has not been imported from
Bloomberg. If QUOTE_MID is imported from Bloomberg,
then QUOTE_MID is used for the CLOSE.

BLOOMBERG_DISABLE_RECORD_LIMIT_CHECK Set to true to enable processing more than 20,000
bonds via BLOOMBERG_UPDATE scheduled task.
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Environment Property Description

BLOOMBERG_DUMMY_ISSUER Only needed if BLOOMBERG_CREATE_ISSUER is False.
Short name of a Legal Entity to use if a Bloomberg issuer
is not found. For example, “BLOOMBERG".

The Bloomberg issuer can be a Legal Entity of role Issuer
with matching short name, or a Legal Entity with
matching BLOOMBERG attribute.

If such a Legal Entity does not exist in the Calypso
system, the application uses the dummy issuer instead. If
this value is not set, Calypso searches for the Legal
Entity with short name BLOOMBERG, and if it does not
exist, it creates it on-the-fly.

BLOOMBERG_ENCRYPT_APP Full path to the Bloomberg encryption application. For
example, “C:\bloomberg\bbdl\des.exe".

(Required to implement password encryption)
[NOTE: Do not set BLOOMBERG_ENCRYPT_APP or

BLOOMBERG_ENCRYPT_KEY if you have an
unencrypted private line to Bloomberg.]

BLOOMBERG_ENCRYPT_KEY Encryption key. If not specified, no encryption is used.

(Required to implement password encryption)

[NOTE: Do not set BLOOMBERG_ENCRYPT_APP or
BLOOMBERG_ENCRYPT_KEY if you have an
unencrypted private line to Bloomberg.]

BLOOMBERG_ERROR_TO_LOG Set to true to log critical error messages into the log file
(errors that may terminate the process when they occur).

Otherwise, the error will be logged in the Task Station
only.

BLOOMBERG_FILE_PREFIX If this property is set, a two-letter filename prefix is taken
from the property. Otherwise, the application uses the
default value, “CY”.

BLOOMBERG_FIRMNAME (Mandatory) The FIRMNAME from the Bloomberg
system. For example, “dI364883".

BLOOMBERG_FLOWS_SAVEDAS_PRODUCT_CUSTO | True or False.

M_DATA When set to True, the system will save the Bloomberg
cashflows as custom cashflows in the Bond product.
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Environment Property Description

BLOOMBERG_FTP_DIR (Optional) Home directory on the Bloomberg system
(remote FTP folder).

BLOOMBERG_FTP_HOST (Mandatory) Host name of the FTP/SFTP server.

For example, “bfmrr.bloomberg.com” for FTP and
“dIsftp.bloomberg.com” for SFTP.
BLOOMBERG_FTP_PASSWORD You can choose to store the Bloomberg FTP/SFTP
(Stored in plain text) password in plain text or in encrypted form.
BLOOMBERG_FTP_PASSWORD_ENCRYPT

(Encrypted prior to storing)

To store a plain text password, enter the password in the
BLOOMBERG_FTP_PASSWORD environment property.

To store the password with encryption, enter the
password in the
BLOOMBERG_FTP_PASSWORD_ENCRYPT environment

property

[NOTE: Manually editing the ENV file to enter the
password into the
BLOOMBERG_FTP_PASSWORD_ENCRYPT
environment property does not encrypt the
password. You must edit and save the environment
properties file using the User Env application.]

(Only one environment property is required. Do not use

both.)

BLOOMBERG_FTP_PORT (Optional) Port number of the FTP/SFTP server.
Defaults to 21 for FTP, 990 for FTPS, and 30206 for
SFTP.

BLOOMBERG_FTP_TYPE (Optional) It can be set to FTP, SFTP, or FTPS.

If it is not set, the connection defaults to FTP.

BLOOMBERG_FTP_USER (Mandatory) User name for the FTP/SFTP server.
See also Feed Configuration if you are using multiple
user accounts.

BLOOMBERG_HTTP_PROXY_HOST HTTP Proxy Connection
BLOOMBERG_HTTP_PROXY_PORT If those environment properties are set, HTTP Proxy
BLOOMBERG_HTTP_PROXY_TYPE connection is used instead of FTP or SFTP.
BLOOMBERG_HTTP_PROXY_USER
BLOOMBERG_HTTP_PROXY_PASSWORD

Host, port, user name and password for HTTP Proxy
connection.
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Environment Property Description

BLOOMBERG_INSERT_ISSUER_ROLE

BLOOMBERG_IMPORT_ABSOLUTE_DIVIDEND_CURV
E

BLOOMBERG_ITERATE_TICKER

BLOOMBERG_LOCAL_DIR

BLOOMBERG_MORTGAGE_FLOATER_COUPON

BLOOMBERG_OVERRIDE_FACE_VALUE

BLOOMBERG_SAVE_FLOWS

The default for BLOOMBERG_HTTP_PROXY_TYPE if not
setis HTTP.
(Optional) True or False. Default is True.

TRUE - If legal entity found without Issuer role, add
the role and set the issuer on the product.

FALSE - Set dummy issuer on the product.

True or False. Default is False.

If set to True, the dividend is displayed without any
manipulation.

If set to False or not set, then we use the difference of
Dividend Amount - Previous Dividend Amount.
(Optional) This property enables Calypso to map an
ISSUER using multiple tickers.

If the property is not set, Calypso retrieves the Issuer
from the Legal Entity attribute, TICKER.

If the property is set, then Calypso attempts to find the
Issuer using LE issuers using the Legal Entity attributes
TICKER, TICKER_1, TICKER_2..., TICKER_N.

(Optional) This property allows specifying the folder
where the .out/.req files are stored.

The default if not set is:

/calypso/<user home>/Calypso/Bloomberg

(Optional) This property controls the import of coupons
for ABS floater bonds.

If not set or set to false, the coupons are not imported.
Is set to true, the coupons are imported.

(Optional) Default face value of the bond regardless of
what is in the MIN_INCREMENT field of the Bloomberg
file or the bond template. For example, “1”.

(Mandatory) True or False.

True = Reconcile Bloomberg cashflows against Calypso.

False = Do note reconcile cashflows.

[NOTE: Unless there is a specific need for custom
cashflows, this setting should be set to False. The
overhead of continually fetching custom cashflows
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Environment Property Description

for the bond will have a negative effect on
performance.]

BLOOMBERG_STATUS_INVALID Not used.

BLOOMBERG_SFTP_KNOWN_HOSTS_FILENAME SFTP Connection Only

Name of Known Hosts file name.
Example:

<user home>\\.ssh\\known_hosts

If not set, host validation is disabled.

BLOOMBERG_SFTP_PRIVATE_KEY_FILENAME SFTP Connection Only

Name of private key file name.
Example:

<user home>\\.ssh\\bbg_id_rsa

If not set, password authentication is performed using
the username and password provided in the environment
properties BLOOMBERG_FTP_USER and
BLOOMBERG_FTP_PASSWORD.

BLOOMBERG_SFTP_PASSPHRASE SFTP Connection Only

Passphrase string if one is used with private key file.
Encrypted in User Environment editor.

BLOOMBERG_SFTP_PASSPHRASE_ENCRYPTED SFTP Connection Only
BLOOMBERG_ENCRYPT_KEY_ENCRYPTED Encryption of Bloomberg password.

If these properties are set, then the passwords are
encrypted, otherwise
"BLOOMBERG_SFTP_PASSPHRASE" and
"BLOOMBERG_SFTP_PRIVATE_KEY_FILENAME" are used
to connect to sftp host.

BLOOMBERG_SFTP_PASSPHRASE_ENCRYPTED is
encrypted in both the User Environment Editor and the
environment file.

BLOOMBERG_TICK_SIZE (Mandatory) True or False.

If the property is set to true, the tick size of 100 is set on
the security. If the property is not set or is false, the tick
size is taken from the QT_SPEC field.

BLOOMBERG_USE_DISABLED_ISSUERS (Optional) True or False. Default is True.
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Environment Property Description

BLOOMBERG_USE_FIXED_MORTGAGE

TRUE - Set the issuer on the product, even if it is
disabled

FALSE - Set dummy issuer on the product

(Optional) True or False.

True to override the index and save the MTGE as Fixed
coupon instead of floating.

BLOOMBERG_USE_PE_PRICING_PARAM_INSTANCE_
TYPE_FOR_BVOL

BLOOMBERG_VAR_COUPON_SCHEDULE

MULTIPLE_LPRODUCT_CUSTOM_DATA

True or False. Default is False.

If set to True, then BVOL instance type will be set as per
the pricing parameter set in the pricing environment.

If set to False or not set, then the instance type will be
set as "CLOSE".

(Optional) True or False.

If False, then we build the Coupon Schedule from
FLOATER_ACC_SCHEDULE if:

Bond is a floater (FLOAT is 'Y")
Reset_Index is not null
Bond is Govt, Muni, or Corp

The dates in FLOATER_ACC_SCHEDULE are assumed to
be the start date, and any missing rates are filled with the
last nonzero rates. The rate at maturity date in the
schedule is set to the last non-zero rate.

Not used.

3.1.6 Feed Configuration

You can also specify a Feed Configurations if you need to use multiple user accounts using Configuration > Market

Data > Feed from the Calypso Navigator.

Create a feed config for each user account for the Bloomberg type.
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A FeedConfig Window >
MName BODL237 Type |Bloomberg ot Is Default
Name Value

HostName disftp.bloomberg.com

Port 30206

Log

UserName dl237

Password 2000000000 0®
SSHPrivateKeyPath Cablp\bbo_id_rsa
SSHPassPhrase 2909000000099
BloombergUserNumber 12345

HostName replaces BLOOMBERG_FTP_HOST

Port replaces BLOOMBERG_FTP_PORT

UserName replaces BLOOMBERG_FTP_USER

Password replaces BLOOMBERG_FTP_PASSWORD

SSHPricateKeyPatch replaces BLOOMBERG_SFTP_PRIVATE_KEY_FILENAME
SSHPassPhrase replaces BLOOMBERG_SFTP_PASSPHRASE
BloombergUserNumber replaces BLOOMBERG_USERNUMBER.

The Feed Config can be selected in the Bloomberg Connect and Bloomberg Update windows.

3.1.7 Setup for Retrieving Private Placements

Creating securities in Bloomberg can be done via the Private Placement Creation (PPCR) application on the client’s
local system. PPCR is a Bloomberg-provided application. Use the submenus to narrow down the type of security to
enter (Mtge, Muni, Govt, etc.).

This functionality is extremely useful to maintain securities created by a Bank that are not part of the Bloomberg
universe. Depending on the setup access controls (Privileges), these securities are only seen by the Bank, or they
may be setup for everyone to see.

When the following environment properties are specified, Calypso adds them to the request file for retrieving data
related to private placements.

e BLOOMBERG_SN - Serial number of the terminal used to retrieve the items. Usually the terminal serial number
associated with the BLOOMBERG_USERNUMBER (based on the license agreement).

e BLOOMBERG_WS - Workstation number, usually 1.

¢ BLOOMBERG_USERNUMBER - User number.
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3.1.8 Starting the Bloomberg Flow Reconciliation Report
You can create a menu item for the action “reporting.ReportWindowSBloombergFlowReconciliation”.

The Bloomberg Flow Reconciliation Report allows you to reconcile Bloomberg cashflows with Calypso cashflows.
This only applies if the environment property BLOOMBERG_SAVE_FLOWS = true.

This report can also be accessed from the Task Station.

|4 Bloombergf kowReconciliation Report PE: default (10/24/04 11:34:38 PM) User: calypso_user[DEFAULT)
Report  View Export

eht Securities 16801 || Only Show Differences
Productid | PRODUCT CODECUSI | flow Date | Calypso lterest | Bloomberg t | Mterost Difference | Calypso Principsl | Boomberg Principal | Principal Differencs
PRODUCT CODE.CUSIP: 912810087
168301 129100M7 11452004 1260 58,125 .00 1,090,000.99 1,000,000

3.1.9 Configuring Bond Templates

Bond templates contain default values that Calypso will store in the database when a particular field is either not
supported or not populated by Bloomberg.

For example, on the Bond Window’s Market tab, Bloomberg does not provide the number of decimals for Price,
Yield, Nominal, and Coupon Rate, nor, in some cases, are Face Value and Total Issued provided.

When Bloomberg does not supply an expected value, the interface generates an exception in the Task Station to
inform users that a default value was used rather than a Bloomberg value.

You should define a Bond Template for each Bond Class (e.g., Bond, Bond Asset Backed, Bond Brady, etc.). The full
list of Bond classes is defined in the domain “bondType”.

You can work with Bond templates using the Bond window (Configuration > Fixed Income > Bond Product
Definition), or using the Bond Defaults window (Configuration > Fixed Income > Default) from the Calypso
Navigator.

From the Bond Window, click Templates to choose a Template operation.

ljﬂand‘ﬂ"mdg — = |i=

File  Help

T & HIX| Gl e

Marne GEneric - E] Product Id a

Security Code | BB_CALC_TYP = | Templates ..

You can choose:

e Convert Defaults to convert any existing Bond Defaults to a template.
e Load Template to load a template in the window to review values.

e Remove Template to delete a previously defined template.
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e Save Template to save a new or modified template, based on the values specified in the Bond window.
Templates should not be saved as “private” so that multiple users can use them.

Calypso suggests that at a minimum, you should create templates for:

- Bond

— Bond Asset Backed
— Bond Brady

— Bond Convertible
— Bond FRN

— Bond MM Discount

Sample Template for Asset Backed Bond's

e Total Issued and Face Value:

| callschedule I I Credit Events I ABS I I Impairment Events I I
Bond | Coupon I Market I Special | CashFlows | Frimary Market | Legal Entities |
Bond Class | BondassetBacked - Bond Type | ABS = | Security Type
IssueDate  DakedDate  Maturity Date Issuer | GOYT, OF USA 1]
mwo - Gavernment of LIS
Country | UMITED STATES -
Issue Price  Issue Yield Currency Redem, Price Redem. Curr, tal Issued Face Yalue
100 0 |UsD - 100 | Ush - 1,000,000.00 1,000

The Total Issued and Face Value values are essential for Calypso to generate cashflows and are sometimes not
provided by Bloomberg. Enter default values for the instances where Total Issued or Face Value are missing.

e Product Codes:

You can click Cedes to define product codes.

A Code 'H'ﬂndnw’

Product Code MName Yalue
Feed
FromBondProduct
GCF General Collakeral |

Saving product codes as part of a template assigns default values to a bond product. Defining Feed as
“Bloomberg” allows for easy identification of products created by the Bloomberg interface as opposed to
manually created products.

e Holiday, Payment Rule, Date Roll, Daycount:
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Call schedule | | Credit Events | ABS | | Impairment Events |
Bond Coupon | Market I Special I ZashFlows I Primary Market I Leqal
Floating Rate Coy | 1J3D » | Davcount  ACTE/ACTE -
Spread 0 Index USD +* | LIBOR - | 3M + |LIEOROL -
Reset Days Z Rate Index Fackor |1 [V Reset Bus Lag  [] Reset In Arrear
Reset Holidays |RYC Reset Dec, 0| NCRHE -
Holidays |MYC D Rl Day 0| Payment Lag 0[] BUS
Pament Rule |UNMADIUSTED - Date Roll | FOLLOYWING -

Bloomberg does not systematically provide the Holidays field. In addition, the Payment Rule and Date Roll
mapping are contained in a mapping table. Default values are provided in the event that a new value is added in
Bloomberg. In Bloomberg, the Daycount definition encompasses the Payment Rule and the Date Roll concepts.

e Settle Days, Accrual Days, Ex-Dividend, and Decimals:

Call Schedule | | Credit Events | ABS |
Eond | Coupan | Market | Special | CashFlows |
Settle Days 1 Accrual Dig. 8| MEAREST -
Price Dec. & NEAREST
Accrual Days 1 Hie Let : v
ield Dec, g | |[MEAREST -
Ex-Dividend 0[] BUS .
Mominal Dec, ]
Record Davs 1 .
Coupon Rate Dec, 3| MOME -
Zapitalization Dec, 10 _NEF'-REST -

Bloomberg does not provide Settle Days, Accrual Days, or Ex-Dividend Days. Nor does Bloomberg provide the
decimal values. Calypso systematically uses the default values provided in the template.

This is particularly important for Ex-Dividend as it has an effect on the Corporate Action process.

Other Bond Templates: US Market - FED, DTC, PHY

In addition to the suggested minimum bond templates, one might add additional templates to pass along other
attributes that are unavailable or difficult to obtain from Bloomberg. For example, in some implementations, it has
been the practice to identify the depository as the DTC, FED, or PHY by using different templates for each unique
attribute. These templates are essentially identical to the “standard” templates except that a product code for DTC,
FED, or PHY is set to true for the corresponding name extension.

When saving these template definitions, be sure to click Yes on the Save Product Codes Confirmation dialog.

Also, all Munis must have Price Dec set to 3 DOWN and Yield Dec set to NEAREST.
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You can define:

e bond

e bond_dtc

e Dbond_dtc_fed

e bond_dtc_muni

e bond_dtc_phy

e Dbond_fed

e bond_phy

e bond_phy_muni

e bondassetbacked

e bondassetbacked_cdn

e bondassetbacked_dtc

e bondassetbacked_dtc_phy
e bondassetbacked_fed

e bondassetbacked_fed_dtc
e bondbrady

e bondconvertible

e bondfrn

e bondfrn_fed

e bondmmdiscount

e bondmmdiscount_dtc

e bondmmdiscount_dtc_phy
e bondmmdiscount_fed

e bondmmdiscount_fed_dtc

3.1.110 Defining ISO ZZ as an “Unknown or Unspecified Country”

Bloomberg uses non-standard ISO codes (i.e., SNAT).

ISO has reserved codes for user defined information. Add a generic country code named “ZZ” for Calypso to use
when Bloomberg provides an unauthorized code.

From the Calypso Navigator, navigate to Configuration > Definitions > Countries:
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F

—— - -

R=RRN X

Counkey

AFEGHANISTAMN -
ALAMND ISLAMDS =
ALEAMNIA

ALGERIA

AMDORRA

AMGUILLA
AMNTARCTICA
AMTIGUA AMD BARE
ARGEMTIMA

ARMEMIA &

< [m] b

150 Code |22
Active From | 01/01/1970
Active To 01012100

Enabled

Autharization [

Mame  LUNKMNOWN OR UNSPECIFIED CDLII"-.IITR\"

Holidays
Location  NOME

Currencies

Attributes ][

Address Format

]
(-]
|

Show Pending Maodifications ]

Help

| |

[ew

| |

Save

] ’ Rename

Delete

| |

»  When you click New, you will be prompted to enter the ISO Code.

» Then enter a name for the country and click Save to save it. The country is then available for selection in the

Bond window.

3.1.1

Defining Issuers

Add Issuers and their corresponding attributes using Configuration > Legal Data > Entities from the Calypso

Navigator.

W Legal Entity [100003/mikey/calypso_user]

Litilities  Help

Shtt Marne IF.ﬁ.r'-.Ir'-.IIE MAE

Full Mame IF.ﬁ.NNIE MAE

Parent I

Country ILISF'.

7l

Inactive As From I

Iser Icalypsu:u_user

Entered Date |n?;12;2|:|u4

|?:41:03 P

Exkernal Ref I

Holidays I

It is recommended to create the following common US issuer names in Calypso:

Disabled Rolels)

{+ Financial

{~ Mon Financial

Skatus IEnahIed

Role(s) |[Issuer
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Name Roles

United States of America
Fannie Mae

Gment Natovernional
Mortgage A

Freddie Mac

Issuer

Issuer

Issuer

Issuer

3.1.112  Mapping Issuers in Bloomberg

In Bloomberg, it is possible to map issuers using two fields:

e Ultimate Parent Company Name

e Ticker

[NOTE: If you also use the Marklt interface in credit derivatives to load legal entities and reference
obligations, an improperly configured system can cause duplicate legal entities (issuers) to appear in
Calypso. For example, Marklt may name issuer Alcoa as “Alcoa Inc.” and Bloomberg may name the same
issuer as “Alcoa Corporation.” Both Markit and Bloomberg should consider these as the same issuer. It is
recommended to use the legal entities imported from the Marklt interface as the benchmark Legal Entity,

if credit derivatives and fixed income are both implemented.]

Using the TICKER Field

Similarly, an Issuer mapping can be made using the TICKER field. This is particularly useful for UKT notes where
Bloomberg incorrectly but consistently uses the ISSUER to identify the paper. As seen in the table below, the Issuer

field identifies the Issue rather than the Issuer.

Ultimate Parent Company Name versus Issuer:

PARENT_COMP_NAME

United Kingdom of Great Britain
United Kingdom of Great Britain
United Kingdom of Great Britain
United Kingdom of Great Britain
United Kingdom of Great Britain
United Kingdom of Great Britain

United Kingdom of Great Britain

TICKER

UKT

UKT

UKT

UKT

UKT

UKT

UKT

ISSUER
TRY 8% 2021

TSY 41/4% 2032
TSY 4% 2009
TSY 52014

TSY 6% 2028
TSY 71/2% 2006

TSY 7 1/4% 2007
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Using the TICKER field to reference the Ultimate Parent Company Name allows the system to accurately identify
the Issuer.

[NOTE: Several Tickers can be attached to one issuer using the legal entity attributes, TICKER, TICKER_1,
TICKER_2, ..., TICKER_N. The environment property BLOOMBERG_ITERATE_TICKER must be set
accordingly to the number of tickers.]

3.1.13 Configuring the Task Station

Specific exception types are available for Bloomberg. Configure your Task Station so that you can monitor all
relevant details related to the Bloomberg integration process.

Ensure that BLOOMBERG_BULKUPDATE, BLOOMBERG_EXCEPTION, BLOOMBERG_INFORMATION, and
BLOOMBERG_UPDATE are defined in the “exceptionType” domain:

5 T

exception Type

J-,"' BLOOMBERG_BULKUPDATE
-1-,“' BLOOMBERG_EXCEPTION
-E BLOOMBERG_INFORMATION
J}“ BLOOMBERG_UPDATE

Open the Task Station (Processing > Task Station from the Calypso Navigator).

Add Bloomberg tabs as needed to the Task Station:

Mame Value
Tab ame
Workflow Types Exception
Books _ANY
Book Atiributes
Event Types EX_BLOOMBERG_BULKUPDATE,EX_BLOOMBERG_EXCEPTION,EX_BLOOMBERG_INFORMATION,EX_BLOOMBERG_UPDATE
Priorites LOW, NORMAL, HIGH, CRITICAL, VERY CRITICAL
Task Statuses NEW, UNDER_PROCESSING, COMPLETED, PASS_OVER, UNCOMPLETE
Enrichment Columns Filter
Task Date Type TaskDatetime
From Tenor -1M
To Tenaor +1M
Catzalog Auto Count |:|
Web Report |:|
Business Days |:|

e BLOOMBERG_BULKUPDATE - To monitor bulk updates.

e BLOOMBERG_EXCEPTION - To monitor errors.

e BLOOMBERG_INFORMATION - To monitor products that are created/ updated.
e BLOOMBERG_UPDATE - To monitor updates.

Once you load those exceptions in the Task Station, you can select a task, and choose Investigate > Product to
view the product details.
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3.2 Setting Bloomberg Mapping Values

You can create a menu item for the action “vloomberg.BloombergConnectWindow” to start the Bloomberg
Connect window.

. BloombergConnect
Litilities
I Import: meFieI

—Settings

Update Mame: ICX_BaseEh:und

—Selections

Sector: I j Security Code: ICLIS[P ﬂ Yalue: I

Sector | Security Code | Value

Choose Utilities > Bloomberg Mapping Setup to open the Bloomberg Mapping window. Double-click the
“Bloomberg Values” label to define mappings between the Bloomberg values and the Calypso values.

. Bloomberg Mapping Window

Floomberg Mappings
=] Bloomberg Values
& VvalueMame
-] AdHocColumns
-] CARounding
|j Calendar Desc / Calypsa Value:
- Columns

-] Columns.CALC_TYP

4

Bloomberg Value:

B[ Columns.COLLAT_TYP << Add
(2] Columns.CPN_CRNCY
(-2 Columns.CPN_TYP == Remove

-] Columns.CRNCY

-] Columns.DAY_CNT

-] Columns. INDUSTRY_GROUP
-] Columns.ISSUER_INDUSTRY
-] Columns.MARKET _SECTOR_DES
-] Columns.REDEMP_CRNCY
-] Columns. SECURITY _TYP
-] Columns. SECURITY_TYP2
-] CurrencyQuotes

[} 7] Exchange

-] Resetindex

-] SECID

= SecCodes

-] DayCounts - Yields - EOM

----- 4* Products
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»  Select a type of data, then enter the Bloomberg value and the corresponding Calypso value.

[NOTE: The “ValueName” data type contains all of the other data types. If you need to add a data type,
you first need to add its name to the “ValueName” data type.]

Using Regular Expressions in Bloomberg Mapping

Patterns should be given in Bloomberg value as 'PATTERN {YOUR PATTERN}".

All the regular expression patterns should be given as per http://docs.oracle.com/javase/tutorial/essential/regex/
Example for ISSUER:

In mapping window for Bloomberg value '‘Columns.ISSUER'

1. ISSUER value in Bloomberg file is 'FEDERAL HOME'.

In mapping window under 'Columns.ISSUER'

e Bloomberg value = PATTERN{"FEDERAL}
e Calypso value = FEDERAL HOME LOAN BANK

Issuer will be created as 'FEDERAL HOME LOAN BANK'.
2. ISSUER value in Bloomberg file is 'GOVT OF FRANCE".
In mapping window under '‘Columns.ISSUER'

e Bloomberg value = PATTERN {FRANCE$}
e Calypso value = FRENCH GOVERNMENT

Issuer will be created as 'FRENCH GOVERNMENT".
Additional info:

e X?-->X,once ornot atall
e X*-->X, zero or more times

e X+ --> X, one or more times

3.21 Mapping Bloomberg DELIVERY_TYP_LIST

The DELIVERY_TYP_LIST is a list of all possible depositories that may be used for settlement for that particular
security. User may use this method rather than individual templates defined for specific depositories.

For example, Bloomberg may return the following list:
;2;3;1;1;FED FUNDS;1;DTC;1;FED WIRE;

This sample list provides the following information:

Definition

The delimiter in use (semi-colon in this case).
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Value Definition

2 Number of dimensions (a single value would have the
dimension of 1, a single row or a single column with more
than one value would have a 2 dimension).

3 The number of rows.

1 The number of columns.

1 The data type (The “1” in this example means
“Character”).

FED FUNDS The character value of the first element (a depository).

1 The data type (The “1” in this example means
“Character”).

DTC The character value of the second element (a
depository).

1 The data type (The “1” in this example means
“Character”).

FED WIRE The character value of the third element (a depository).

In Calypso, spaces in depository names are replaced by the underscore character, so “FED FUNDS” becomes
FED_FUNDS in the database. You will need to map the depository Security Codes, Product Codes, and Product
Mappings specific to your Calypso implementation. Mapping procedures are described below.

All Possible Delivery Types

o ACT

o ARGENT: CAJ

o AUSTRACLEAR - NYSE:ASX - Sole central securities depository in Australia
e BKSERVE

e BOJ - Bank of Japan - payments / JGB clearance
e BUNDESBANK

e CDC

e CDP

e CDS - Canadian Depository

e CENTRAL GIL

e CHESS

e CLEARING HOUSE
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e CLEARSTREAM FFT
e CLEARSTREAM LUX

¢« CMU
¢« CVM
e DECKUNGSSTO
e DTC

e ECB-TIER 1 - European Central Bank
e ECB-TIER 2 - European Central Bank
e EEUROCLEAR

e ESPACLEAR

e EUROCLEAR BELG

e EUROCLEAR FRANCE

e EUROCLEAR NETH

e EUROCLEAR UK IR

e FED FUNDS
e FED WIRE

e GR-CSD

e |IBERCLEAR

e INDEVAL - Mexico
e |RELAND STL

e KSD

e KSEI

e MONTE TITOL

e MONTREAL TR

e MUENDELSICH

e NSD

e NZ-AUSTRACL

e OKB

e PH-PCD

e RU-NDC

e SEGA - Now, SIS - SegalnterSettle AG - Swiss
e SSTS

e SUOMEN ARVO

e TH-TSD

e TRACE

e TRACE ELIGIBLE
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e TU-ISE

e VPC DENMARK
e VPC SWEDEN
e VPS

3.2.2 Ad Hoc Columns

The AdHoc Columns define which Bloomberg data items are requested in the Bloomberg Cash Flow Update
process. This process is defined using Utilities > BloombergCashFlowUpdate. It is necessary that all the
identification values remain in this list, i.e., ID_BB_UNIQUE, ID_CUSIP, ID_ISIN and MARKET_SECTOR_DES. The
cashflows are retrieved via the other two data values in the list, i.e., DES_CASH_FLOW and MTG_CASH_FLOW.
e DES_CASH_FLOW

e |ID_BB_UNIQUE

e |ID_CUSIP

e ID_ISIN

e MARKET_SEC_DES

e MTG_CASH_FLOW

If using External Cash Flows (BondAssetBacked.USE_EXTERNAL_FLOWS_FOR_PRICING=true) please add:

HIST_CASH_FLOW
MTG_PREPAY_SPEED

3.2.3 Bond Name Mapping

By default, Calypso creates bond names from Bloomberg using either SECURITY_DES, TICKER, or ID_BB_UNIQUE, if
available, in that order.

Rather than using the default naming convention, it is possible to use Bloomberg mapping to create the bond name
using different fields to handle instances where SECURITY_DES is not unique (e.g., Series bonds).

Procedure to Generate Bond Names from Non-Standard Fields
»  Launch the Bloomberg Mapping Window.
» Navigate to BloombergValues > ValueName.

» In Bloomberg Value, add BondName:

August 2024 Revision 68.0 / Approved Page 34 /128
Private and Confidential



lol Nasdaq

Nasdaqg Calypso

Bloomberg DL Products Integration Guide / Version 12.17.0

I Bloomberg Mapping Window =10l x|

Next, using the available Bloomberg fields, enter the Bloomberg fields you wish to use to generate Bond Names:

I Bloomberg Mapping Window 10| x|

B valueMame
L 4% valueName
------ 4% AdHocColumns
-
------ 4* CaRounding
t-4# Calendar
42 Columns

=4

L

Mame: ValueMame

Bloomberg Value: BondMame

Desc [ Calypso Value:

=] Eloomberg values
603 valueName
&1 AdHocColumns
= Bondiame
R Y ECURITY DES-SERIES
,j CARounding
.j Calendar

-l 4
L
Mame: BondMame
Bloomberg Value: SECURITY_DES-SERIES
Desc [ Calypso Value: Field values used to generate bond names

The example shown demonstrates the use of the fields, SECURITY_DES and SERIES. Note that the fields are
separated with a hyphen: “SECURITY_DES-SERIES”.

[NOTE: Bond Names are only created when importing bonds from Bloomberg Connect. Bloomberg Update
does not generate Bond Names. The maximum length of the Bond Name field in Calypso is 32 characters.
If the Bond Name generated using this alternate method exceeds 32 characters, then Calypso reverts to
the default naming scheme, which uses either SECURITY_DES, TICKER, or ID_BB_UNIQUE, in that order.]

3.24

Calendar Mapping

Calendar is a direct mapping of the Bloomberg value for a calendar to Calypso’s value for a calendar. For example,
the US calendar in Bloomberg is mapped to the NYC calendar value in Calypso. Note that Desc/Calypso Value in this
case identifies the Calypso value of this value mapping.

I Bloomberg Mapping Window

| Bloomberg Mappings
=17 Eloomberg values
- Walusiame
- AdHocColumns
B~ Calendar

------ 51
IEIJ Columns
- Columns CALC_THP

a| 4
il

=l

=10l x|
Narne: ICaIendar
Bloomberg Yalue: IUS
Desc | Calypso Yalue: INYC

=< Add |
> Remove |
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The entry in Bloomberg Value represents the Bloomberg code for that calendar. Ensure that the target calendar in
Calypso (e.g., NYC) is also defined as a holiday calendar in Calypso.

3.2.5 Columns Mapping

Columns define which Bloomberg data items are requested by default in the Bloomberg Request process. All of
these columns are requested regardless of the security market sector unless a custom “Configuration” is supplied.
Custom Configuration is best reserved for retrieving Quotes or Corporate Actions. Columns are a superset of the
data generally required for any of the markets supported. Calypso strongly advises that users do not remove any of
these values as there is a chance that such removal may cause subsequent errors in the Bloomberg to Calypso
mapping process. You may, however, add Bloomberg data items to this list. However, if not customized, Calypso
will neither process nor save the additional data items out-of-the-box.

I Bloomberg Mapping Window

=10l x|

] Bloomberg Mappings
=17 Bloomberg Yalues
- @ valueMame
j &dHocColumns
+j CARounding
-] Calendar
a3

b_olurmnns

AMT_ISSUED

ANNOUNCE_DT

BASE_ACC_RT_DT

BASE_CPI

BRADY

BULLET

BVOL_RFR_CAP

BVOL_RFR_SWAPTION

CALC_TYP

CALC_TYP_DES

CALENDAR_CODE

CALLED

CALLABLE

4
L4

Mame: ICUIumns

Bloomberg Yalue: I

Desc [ Calypso Yalue: I

Field Name Field Name (continued)

MTG_FACTOR_SET_DT

MTG_FACTOR_SET_DT_END_ACC_DT

MTG_FIRST_RESET_CAP_DOWN
MTG_FIRST_RESET_CAP_UP
MTG_FIRST_RST_DT
MTG_FLT_LAST_RST
MTG_FLT_NXT_RST
MTG_HIST_CPN
MTG_HIST_FACT
MTG_HIST_WAC

MTG_HIST_WAM

MTG_FACTOR_SET_DT_START_ACC_DT

MTG_FACT_SET_DT_STRT_NEXT_ACC_DT
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Field Name Field Name (continued)

CALLED_DT
CALL_SCHEDULE
CMPD_FREQ_CNV_YLD
CNTRY_ISSUE_ISO
COLLAT_TYP

CONVERTIBLE

CV_COMMONLISIN
CV_START_DT

CV_UNDERLYING_ID_BB_UNIQUE

MTG_LIFE_CAP
MTG_LIFE_FLOOR
MTG_LOAN_AGE
MTG_LOAN_MRGN
MTG_LOOKBACK

MTG_ORIG_WAM

COUNTRY_ISO MTG_PAY_DELAY
CPN MTG_PER_RT_CAP
CPN_ASOF_DT MTG_POOL_NUMBER
CPN_CAP MTG_POOL_TYP
CPN_CRNCY MTG_PREPAY_SPEED
CPN_FLOOR MTG_PREPAY_TYP
CPN_FREQ MTG_RT_CHG_FREQ
CPN_RATE_FIX_METH MTG_TYP

CPN_TYP MTG_WACPN
CRNCY MTG_WAM

CUR_CPN MTG_WAM_NXT_RST
CV_CNVS_PX MULTI_CPN_SCHEDULE

MULTI_CPN_SCHEDULE_TYP

MUNI_FED_TAX

MUNI_ISSUE_SIZE

CV_UNTIL MUNI_MTY_SIZE
DAY_CNT MUNI_STATE_TAX
DAY_CNT_DES NAME
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Field Name Field Name (continued)

DVD_DECLARED_DT

EQY_PRIM_EXCH_SHRT

FLOATER_ACC_SCHEDULE

FLT_CPN_CONVENTION

FLT_PAY_HOLIDAY_CDR

FLT_REFIX_HOLIDAY_CDR

DAY_PAYER_FREQ PAR_AMT
DES_CASH_FLOW PAY_RULE

DES_NOTES PCT_SINKER
DTC_ELIGIBLE PENULTIMATE_CPN_DT
DVD_CRNCY PRIOR_CLOSE_MID

PRO_RATA_SINK

DVD_EX_DT PUTABLE
DVD_PAY_DT PUT_SCHEDULE
DVD_RECORD_DT PX_ASK
EQY_DVD_FREQ PX_BID
EQY_DVD_SH_LAST PX_CLOSE_DT

PX_DIRTY_CLEAN

EQY_SH_OUT_ACTUAL PX_DT_1D
EXCH_CODE PX_HIGH
EX_DIV_DAYS PX_LAST
FACTOR_SCHEDULE PX_LOW
FIRST_CPN_DT PX_OPEN

PX_TRADE_LOT_SIZE

PX_YEST_ASK

PX_YEST_BID

PX_YEST_CLOSE

FLT_SPREAD PX_YEST_DT
HIST_CASH_FLOW QT_SPEC
ID_BB QUOTE_ASK
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Field Name Field Name (continued)

ID_BB_COMPANY
ID_BB_SECURITY
ID_BB_UNIQUE
ID_COMMON
ID_CUSIP

ID_ISIN
INDUSTRY_GROUP
INDUSTRY_SECTOR
INT_ACC_DT
ISSUER

ISSUE_DT
ISSUE_PX

IS_CD
IS_INDEX_LINKED
IS_SECURED
IS_SUBORDINATED
LAST_UPDATE_DT
LOOKBACK_DAYS
LU_MTG_RT_CHG_FREQ
MARKET_SECTOR_DES
MATURITY
MIN_INCREMENT
MTG_ACC_RT

MTG_ACC_RT_START_DT

QUOTE_BID
QUOTE_MID
QUOTE_PRIOR_ASK
QUOTE_PRIOR_BID
QUOTE_PRIOR_MID
QUOTE_TYP
RATEDET_CALENDAR
REDEMP_VAL
REFERENCE_INDEX
REFIX_FREQ
RESET_IDX
RTG_FITCH
RTG_MOODY
RTG_SP
SECURITY_DES
SECURITY_TYP
SECURITY_TYP2
SETTLE_DT

SINKABLE

SINK_FUND_REDEMP_METHOD

SINK_SCHEDULE

STEPUP_CPN

STEPUP_CPN_SCHEDULE

STEPUP_DT
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Field Name Field Name (continued)

MTG_CALENDAR_CODE TICKER
MTG_CASH_FLOW WHEN_ISSUED
MTG_DEAL_TYP WITHHOLDING_TAX
MTG_FACTOR ZERO_CPN

MTG_FACTOR_NUM_DT

MTG_FACTOR_PAY_DT

MTG_FACTOR_PAY_RT

In general, the Columns.XXXX nodes supply a drop-down list for Product Mapping.
P Product Mapping is explained in detail in Configuring Product Codes in Calypso.

Product Mapping allows the user to utilize any Bloomberg data in combination to map to the Calypso values of
Product Type and Product Sub Type to a Template. As discussed in previous sections, Templates provide certain
default data that Bloomberg does not provide. If a Columns.XXXX node is defined and given a list of sub-nodes, the
subnodes form a drop-down list from which the user may choose during Product Mapping. The user may use any
Bloomberg data item for Product Mapping with a user-entered data value or values. The Columns.XXXX nodes
facilitate this process by supplying a drop-down list for possible data values rather than relying on the user
remembering and entering specific values.

Issuer Industry Codes

The Bloomberg Issuer Industry field is occasionally used for Product Mapping (i.e., mapping Bloomberg Fields to
Calypso Product Type, Product Subtype and Template Name. It is also a Columns node
(Columns.ISSUER_INDUSTRY), which provides values for a drop-down of available values for use in Product

Mapping.
I Bloomberg Mapping Window

[ Columns CRECY =]
-] Columns.DaY_CNT

[ Columns, INDUSTRY _GROURP
balumns ISSUER _INDUSTRY
i BANK

4* FINAMCIAL

¥ GAS

Marne: ICDIumns.ISSUER_INDUSTR‘f

Bloomberg Yalue: I

Desc [ Calypso Yalue: I

Industry Codes Mapping

Industry Codes can be used for Product Mapping. Because it is a Columns.XXXX field, items entered here will
provide the user with a dropdown selection of defined nodes.

Currently this mapping is only used by the Backed Asset Bond class to populate the field Collateral of the ABS tab.
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I Bloomberg Mapping Window -0l =|
= Colurns INDUSTRY _GROUP | :

Agriculture

Airlines

Alkernative Investment
apparel

Asset Allocation Fund
Auko Floor Plan ABS

Marne:
Bloomberg Yalue:

I

Desc | Calypso Walue:

<< fdd |
== Remove |

ICDIumns.INDUSTRV_GROUP

I.ﬁ.gencv Collat Cho

IMurtgages

You must use the Domain Values window to predefine these values in the “BondAssetBacked.collateral Type”

domain:

z Domamn Values Window

sewch | Frd | veke

¥ Balarcelrelate -]
¥ BardngProrty
+ ] barer type _j

¢ ] seAstDaeRiol

& ) biegCalodstors

& ) bt verts

& 1 Bond Pricer

¢ ] Bond sbtype

=] BondAssetBacked. collateralType

| =42 AutoLoans
42 Commercial Home Equity Loans
~o 42 Credit Card

fvortgages
42 Residential Home Equity Loans
.42 Student Loans

- j DN OAT DR S Doow SUov |y

¢ ) BondAssetBacked Pricer

3.2.6

MName: IBondAssetBacked.collateraIType

Value: IMortgages

C~l:|

Compoundedindices Mapping

Compoundedindices is a mapping of Bloomberg to import RFR Compounded Index (SOFR, SONIA, etc.) bonds. This
will be applicable for different RFR Compounded Indices each having its own Bloomberg Value, below taking an
example of SOFR Compounded Index.

The Bloomberg value for SOFR Compounded Indices is SOFRINDX, which we should define under
CompoundedIndices in the Bloomberg mapping window in the "Bloomberg Values" section.

A Bloomberg Mapping Window

+- ] Columns.REDEMP_CRNCY
+ ] Columns SECURITY_TYP
- Columns. SECURITY_TYF2

=1 ] Compoundedindices
=or o

+- ] CurrencyQuotes

#1-] Exchange

+ ] IssueCurrentRatings

i  IssueQutlookRatings
¥ MBS ARM Cpn Rounding
4* MBS Rate Change Freq

1771 DrmmaCasiees

- O
|4

fal .‘ )

Name: Compoundedindices

Bloomberg Value: SOFRINDX

Desc [ Calypso Value:

=> Ramove

L

*,
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In Resetindex map the defined Compounded Indices "SOFRINDX" to Calypso Value of SOFRINDEX configured in
Calypso system.

Name: Resetindex
Bloomberg Value: SOFRINDX
Desc / Calypso Value: MM.USD.SOFRINDEX. 1D.FED

NOTE: Refer to Getting Started documentation on how the Calypso Rate Index definition of SOFR and
SOFRINDEX index.

3.2.7 Currency Quotes Mapping

Currency Quotes are a direct mapping of the Bloomberg values for currency quotes to the Calypso values for
currency quotes. For example, the USDJPY currency quote value in Bloomberg is mapped to the FX.USD.JPY
currency quote value in Calypso.

3.2.8 Exchange Mapping

Exchange is a direct mapping of the Bloomberg value for an exchange to the Calypso value for an exchange. For
example, the LI exchange value in Bloomberg is mapped to the LSE exchange value in Calypso to indicate the
London Stock Exchange.

3.2.9 Reset (Reference) Index Mapping

Floating Rate products require a mapping between the Bloomberg Value and the Calypso Value. Simple reference
indices are entered under the Resetindex Node.

J Bloomberg Mapping Window =10l x|
] Columns, DAY _CHT -] :
j Colurmns INDUSTRY _GROUP Name: IResetIndex

£+ Columns MARKET_SECTOR_DES
#-(] Columns. REDEMP_CRNCY
#-( Columns, SECURITY_TYP

tl-( Columns, SECURTTY_TYP2 Dest | Calypsa Yalue: IMM.USD.LIBOR. 1M,BBA

=] ResetIndex
<< Add |

> Remave

Bloomberg Yalue: ILIBORDIM

|

------ 4% LIBORO3M

------ A% LIBOROGM

------ 4% LIBOR12M
-] SECID

j SecCodes

-] DayCounts - Yields - EOM

E|j Products b
D =
Load | Close
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Desc/Calypso Value is the quote name that Calypso uses for a particular Bloomberg Value.

o Reference index quote names are defined in Calypso as: “MM.currency.reference index.tenor.source”

e Forexample, “MM.USD.LIBOR.TM.BBA”.

e Swaps are defined in Calypso as: “Swap.tenor.currency.reference index.index tenor/reset tenor.source”
e For example, “Swap.3Y.GBP.LIBOR.6M/6M.T3750".
e Currency Quotes are defined in Calypso as: “FX.Currency.Currency.tenor”

e For example, “FX.EUR.USD.TM” or “FX.JPY.EUR” (tenor is optional). The application generates an exception if it
does not find a mapping when loading the security.

3.2.10 Sec Codes Mapping

Sec Codes map a Bloomberg field name to a Calypso Product Sec Code.

. Bloomberg Mapping Window

TR Comnms, S ORI T T _TTPL
[+ 1] ResetIndex

[ SECID

[=1-{7] SecCodes

------ A CALC_TYP

------ 4F CALC_TYP_DES

------ 4% CPN_TYP

------ 42 DTC_FELIGIELE

D_BB_LINIOUE
------ 4% ID_COMMON
------ 4* ID_CUSIP

------ 4% ID_BE_ULTIMATE_PARENT_CO_NAME v Add

=

Mame; SecCodes

Bloomberg Yalue:

Dese [ Calypsao Yalue: BE_IIMIQLE

== Remove

ID_EE_UMIGUE

Each client will map a set of Security Codes based on Products contained in their portfolio. For fields that originate
from Bloomberg, it is typical to prefix those fields in Calypso with “BB_". The table below provides the list of

common mappings.

Bloomberg Value Desc / Calypso Value

AU_OTC_ELIGIBLE_COLLATERAL_TYP
CA_OTC_ELIGIBLE_COLLATERAL_TYP
CALC_TYP

CALC_TYP_DES

CALLABLE
CH_OTC_ELIGIBLE_COLLATERAL_TYP

COLLAT_TYP

AU_OTC_ELIGIBLE_COLLATERAL_TYP
CA_OTC_ELIGIBLE_COLLATERAL_TYP
BB_CALC_TYP

BB_CALC_TYP_DES

BB_CALLABLE
CH_OTC_ELIGIBLE_COLLATERAL_TYP

BB_DEBT_SENIORITY
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Bloomberg Value Desc / Calypso Value

CPN_TYP

DAY_CNT

DELIVERY_TYP
EU_OTC_ELIGIBLE_COLLATERAL_TYP
HK_OTC_ELIGIBLE_COLLATERAL_TYP
ID_BB

ID_BB_UNIQUE

ID_COMMON

ID_CUSIP

DTC_ELIGIBLE

ID_ISIN

INDUSTRY_GROUP
INDUSTRY_SECTOR
INDUSTRY_SUBGROUP

ISSUER

IS_INDEX_LINKED

IS_SUBORDINATE

IS_UNSECURED
JP_OTC_ELIGIBLE_COLLATERAL_TYP
MARKET_SECTOR_DES
MTG_DEAL_TYP
MTG_POOL_NUMBER
MUNI_FED_TAX

MUNI_STATE_TAX

BB_CPN_TYP

BB_DAY_CNT

BB_DELIVERY_TYP
EU_OTC_ELIGIBLE_COLLATERAL_TYP
HK_OTC_ELIGIBLE_COLLATERAL_TYP
BB

BB_UNIQUE

COMMON

CUSIP

BB_DTC_ELIGIBLE

ISIN

BB_INDUSTRY_GROUP
BB_INDUSTRY_SECTOR
BB_INDUSTRY_SUBGROUP
BB_ISSUER

BB_IS_INDEX_LINKED
BB_IS_SUBORDINATE
BB_IS_UNSECURED
JP_OTC_ELIGIBLE_COLLATERAL_TYP
BB_MARKET_SECTOR_DES
BB_MTG_DEAL_TYP
BB_MTG_POOL_NUMBER
BB_MUNI_FED_TAX

BB_MUNI_STATE_TAX
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Bloomberg Value Desc / Calypso Value

NAME

PRO_RATA_SINK

RESET_IDX

SECURITY_TYP

SECURITY_TYP2
SG_OTC_ELIGIBLE_COLLATERAL_TYP
TICKER
TW_OTC_ELIGIBLE_COLLATERAL_TYP
US_OTC_ELIGIBLE_COLLATERAL_TYP
ZA_OTC_ELIGIBLE_COLLATERAL_TYP

ZERO_CPN

BB_NAME

BB_PRO_RATA_SINK

BB_RESET_IDX

BB_SECURITY_TYP
BB_SECURITY_TYP2
SG_OTC_ELIGIBLE_COLLATERAL_TYP
BB_TICKER
TW_OTC_ELIGIBLE_COLLATERAL_TYP
US_OTC_ELIGIBLE_COLLATERAL_TYP
ZA_OTC_ELIGIBLE_COLLATERAL_TYP

BB_ZERO_CPN

Security codes for CSDR information:

e CSDR_SME_Indicator - Trading venues classification based on average market capitalization

e CSDR_Buyln_deliveryTimeframe - Number of days the Buyln Agent disposes to deliver the securities to the

receiving party

e CSDR_Penalty_Category — Type of security for CSDR

e CSDR_ExtensionPeriod - Number of days of days of the extension period

o CSDR_Eligibility — Eligible to CSDR regulation

e CSDR_MarketValue_Category — Used to calculate Buyln Cash Compensation
e CSDR_SDR_Penalty_Rate — Penalty rate

3.211 Day Counts — Yields — EOM

Bloomberg essentially uses the Day_Cnt field to record a variety of information, which in Calypso translates to a
combination of Payment Rule, Date Roll, Daycount, Yield Method, Acc DayCount, and finally, Rolling day logic,

which is used when pay dates fall on the last day of one month but not in another.

Calypso uses the actual maturity day or penultimate day as the rolling day when Rolling Day Logic is set to “NON
EOM” in your Bloomberg Mapping. When Rolling Day Logic is set to “EOM,” Calypso uses the last day of the
maturity month or the penultimate month as rolling day.

The mapping in Daycount Yields - EOM defines this mapping.
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A Bloomberg Mapping Window

-4 ACTE/ACTE - USSTREET - NON EOM

Date Rule

-] TradeAmendRecordTypes 4 Bloomberg Mapping
| TradeCancelRecordTypes r
([ TradeNewRecordTypes Mame Value Select
=] DayCounts - Yields - EOM DAY_CNT 35
- 4% 30/380 - ISMA - EOM MTG_DEAL_TYP
4% 30380 - ISMA - EOM ISSUER
o4 30,360 - ISMA - EOM RESET_IDX
- 4% 30350 - ISMA - NON EOM SECURITY_TYP
4% 30/380 - USSTREET - EOM MTG_POOL_TYP
- 4% 30350 - USSTREET - EOM AMT_ISSUED
- 4% 30350 - USSTREET - EOM PAY_RULE
- 4% 30,380 - USSTREET - NON EOM
- 4% 30,380 - USSTREET - NON EOM
4% 30385 - ISMA - EOM
- 4% 30355 - ISMA - NON EOM
- 4% 30/385 - USSTREET -EOM
- 4% 30365 - USSTREET - NON EOM Calypso Values
4% 30E%/360 - ISMA - NON EOM Payment Rule Date Roll Daycount Date Rule
- 4% 30E*/380 - USSTREET - EOM
- 4% 30E*360 - USSTREET - EOM UMADIUSTED FOLLOWING e 30/360 £
-4 30E%/360 - USSTREET - NON EOM Yield Method Rolling Day Logic Acc Daycount
- 4% 30E[360 - ISMA - NON EOM ISMA EOM o 30/360 "
- &% ACT/360 - MXN_182 - EOM
- 4% ACT/IAN - | ISSTRFFT - FOM
A Bloomberg Mapping Window *
- 4% ACT/380 - USSTREET - EOM 4 Bloomberg Mapping
- 4% ACT/360 - USSTREET -EOM 4
- 4% ACT/360 - USSTREET - EOM Name Value Select
-4 ACT/380 - USSTREET - EOM DAY_CNT 1
-4 ACT/380 - USSTREET - EOM CALC_TYP 197
- 4% ACT/360 - USSTREET - EOM MTG_DEAL_TYP
4% ACT/360 - |USSTREET - EOM ISSUER
-4 ACT/380 - USSTREET - EOM RESET_IDX
- 4% ACT/380 - USSTREET - NON EOM SECURITY_TYP
- 4% ACT/385 - USSTREET - EOM MTG_POOL_TYP
- 4% ACT/385 - USSTREET - EOM AMT_ISSUED
- 4% ACT/385 - USSTREET - EOM PAY_RULE
- 4% ACT/385 - USSTREET - EOM
- 4% ACT/385 - USSTREET - NON EOM
- 4% ACT/385 - USSTREET - NON EOM
e % " _TB/ACTE - BankOfCanada - EOM
- 4% ACTB/ACTB - BankOfCanada - EOM Calypso Values
-4 ACTB/ACTB - USSTREET - EOM Payment Rule Date Roll Daycount Date Rule
- 4% ACTB/ACTB - USSTREET - EOM
- 4% ACTE/ACTE - USSTREET - EOM UMADIUSTED FOLLOWING e ACTB/ACTB ~
-4 ACTB/ACTB - USSTREET - EOM Yield Method Rolling Day Logic Acc Daycount
++42 ACTB/ACTE - USSTREET -NON EOM BankOfCanada EQM v ACT/385 ~

Special rolling conventions can be used in place of the standard Date Roll and Rolling Day Logic through the
inclusion of a custom designed Date Rule. Once attached to the Day Counts - Yields - EOM configuration, the Date
Rule will control the schedule roll day and payment date logic.

P Please refer to Calypso Getting Started documentation for complete details on creating date rules.
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A Bloomberg Mapping Window — O X
-+ 42 30/360 - ISMA -EOM " : Bloomberg Mapping
- 4% 30/360 - ISMA - NON EOM
. 4% 30/360 - USSTREET - EOM Mame Value Select
- 4% 30/360 - USSTREET - EOM MTG_DEAL_TYP CMBS-CLO
- 4% 30/360 - USSTREET - EOM PAY_RULE on 4th Bus. Day Following 10th Day (Bus. Adj'd).
- 4% 30/360 - USSTREET - NON EOM ISSUER EXMT Ltd JAREIT CRE Trust
- 4% 30/360 - USSTREET - NON EOM RESET_IDX SOFR.30A
4% 30/365 - ISMA -EOM DAY_CNT 102
- 4% 30/365 - ISMA - NON EOM SECURITY_TYP
- 4% 30/365 - USSTREET - EOM MTG_POOL_TYP
- 4% 30/365 - USSTREET - NON EOM AMT_ISSUED

- 4% 30E*(360 - ISMA - NON EOM
- 4% 30E*(360 - USSTREET - EOM
4% 30E*/360 - USSTREET - EOM
- 4% 30E*(380 - USSTREET - NON EOM
- 4% 30E/380 - ISMA - NON EOM
- 4% ACT/360 - MXN_182 - EOM Calypso Values

(ACT360 - USSTREET - EOM Payment Rule Date Roll Daycount Date Rule
4% ACT/360 - USSTREET - EOM
3% ACT/360 - USSTREET - EOM ADIUSTED “ FOLLOWING “ ACT/360 v 4BD_Offsetfrom 10th E:}
- 4% ACT/360 - USSTREET - EOM Yield Method Rolling Day Logic Acc Daycount
A N -
42 ACT/360 - USSTREET - EOM USSTREET v EOM v ACT[360 v

- 4% ACT/380 - USSTREET - EOM

[NOTE: Only Date Rules of type DAY_FIXED will be displayed in the Day Counts - Yields - EOM
configuration.]

Configuring Product Codes in Calypso
Additional information from Bloomberg can be stored as Product Codes as shown below.

From the Calypso Navigator, navigate to Configuration > Product > Code to open the Product Code Window.

A product code windon -~ ==
Mame :DTC v: E Tvpe .l:ll:ll:llean |

[ Uniigue Searchable [T Mandatory
Product  ALL E
Mame Twpe Unigue  Searchable  Mandatory  Produck L
False
DebbSeniority tring False False False aLL
DesignatedPrioriky tring False False False aLL
FED boolean |false krue False ALL

If the values DTC, FED, and Feed are not available on the “Name” dropdown, use the Domain Values window to add
them to the securityCode domain. Add a list of values for the product codes in the domains,
“securityCode.STATUS”, “securityCode.FED”, and “securityCode.DTC”. If these domains do not exist, create them
using the Domain Values window.
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Adding Domain Names and Domain Values

To add a new Domain Name, open the Domain Values window, and select the “domainName” domain.

Enter the name of the new domain in Value. Enter a Comment if desired.

[ Domain Values Window -0l x|
Search: Idomain Find [~ value
=3 - Mamne: IdomainName

4¥ ADR.Pricer

A% ADR.subtype iy Yalue: IADocSampIeDomain
A% AccountCalculationType
4% AccountHolderRole Comment: IA sample domain For documentation
A% ArronintSatHerethnd

Click Add to move the new domain name to the list of domains, and save.

Click Load to make the new domain available:

P Domain Values Window o [m] |
Search: Idomain Find ||_ Yalue
\j disruptionFallbacks ﬂ Marne: IdomainName

domainMame

A DocSarnpleDomain iy Yalue: IADocSampleDomain
A* ADR. Pricer
: 4% ADR.subtype Carmment: IA sample damain For dacumentation

Select the new domain from the list to add domain values, if desired.

I Domain Values Window ] 5]
Search: IADOc| Find ||- value
------ 4* accountSuspendedStatus ;I Marne: IADocSampIeDomain
J accountType =
-] accRuleType Value: IND
J addressMethiod
o177 ADocSampleDomain Comment: ISampIe Mo

When creating a bond, you can use STATUS to define a status to make use of Trade workflow rules. This field is
not mandatory.

Any product code whose definition includes Searchable can be accessed in the Product Chooser window when

performing a bond query. From the Calypso Navigator, navigate to Configuration > Fixed Income > Bond Product
Definition, and click Lead on the bottom of the window.

With the Product Chooser open, select Bond, click Query, then right-click in the spreadsheet to access the context

menu. Select Configure Columns to open the Configure Columns window. Add or remove fields as desired, then
click OK to save.

. Configure Columns
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3.2.12 Product Code Mapping (Subtypes)

The Product Mapping screen automatically defines the Calypso subtypes for a product based on Bloomberg
criteria.

Any field imported from Bloomberg can be used to define that mapping. The most commonly used fields are:

e MARKET_SEC_DES
e SECURITY_TYP

e CPN_TYP

e SECURITY_TYP2

. Bloomberg Mapping Window -0l x|

1 Bloomberg Mappings 4

j EBloomberg Yalues 4

Fl-{7] DayCounts - Yiglds - EOM Name Walue Select

B3 Products COUNTRY 150 A
E‘j MARKET_SECTOR_DES Carp
HE CPN_TYP

' SECURITY_TYF

“4* BondConvertible/Standard SECURITY_TvP2

4® BondFRMfStandard

{0 b2 BondMMDiscount/Discount

j Gowt

i~ Bloomberg Mapping

5] Mge
-3 Mo Calypso values
Product Type Product Sub Type
IBond 4| ICDN =]

Template Mame

Ibond_canadas LI

To choose which Bloomberg fields to evaluate during the mapping process, right-click on the Bloomberg Mapping
table to access the Context Menu and then click Configure Rows to open the field selector:

[N x|

MARKET SECTOR_DES
(CPR_THP
SECLRITY_TYP
BRADY SECURITY_TVPZ

ELLLET

BASE_ACC_RT_DT
BASE_CPI

Add fields as necessary to identify each desired subtype and Bond Template. The following table provides a list of
suggested subtypes:

Bloomberg Product Bloomberg Fields Values Calypso Values
Bond/Corp MARKET_SECTOR_D | Corp Product Type: Bond
ES

Product Sub Type: Corp

Template Name:
bond_generic

Bond/Corp MARKET_SECTOR_D | CORP Product Type: Bond
ES usD Product Sub Type: Corp
CRCNY

Template Name: bond_dtc
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Bloomberg Product

Bond/Corp

Bond/Govt

Bond/Govt

Bond/Govt

Bond/Govt

Bond/Govt

Bond/Govt

Bloomberg Fields

MARKET_SECTOR_D
ES

CRCNY
DELIVERY_TYP
MARKET_SECTOR_D
ES

SECURITY_TYP
INDUSTRY_GROUP
MARKET_SECTOR_D
ES

CRCNY
INDUSTRY_SECTOR
MARKET_SECTOR_D
ES

CRCNY
INDUSTRY_GROUP
MARKET_SECTOR_D
ES

CRCNY
DTC_ELIGIBLE
INDUSTRY_GROUP
MARKET_SECTOR_D
ES

SECURITY_TYP
CRCNY
ISSUER_INDUSTRY

MARKET_SECTOR_D
ES

SECURITY_TYP
CRCNY

INDUSTRY_INDUST
RY

Values

CORP
usSD
Y

Govt
CANADIAN

Regional(state/provnc)|Sovereign

Govt

EUR|GBP|JPY|DEM|ESP|FRF|SKR]
ITL

Government

Govt
UsD

Regional(state/provnc)|Sovereign

Govt
UsD
Y

Regional(state/provnc)|Sovereign

Govt

us
DOMESTIC|GLOBAL|DOMESTIC]
MTN

uSD
GOVT AGENCY

Govt

us
DOMESTIC|GLOBAL|DOMESTIC]|
MTN

usSD
GOVT AGENCY

Calypso Values

Product Type: Bond
Product Sub Type: Corp
Template Name:
bond_dtc_phy

Product Type: Bond

Product Sub Type: Foreign
Gov Non-USD

Template Name: bond

Product Type: Bond

Product Sub Type: Foreign
Gov Non-USD

Template Name: bond

Product Type: Bond

Product Sub Type: Foreign
Gov USD

Template Name: bond

Product Type: Bond

Product Sub Type: Foreign
Gov USD

Template Name: bond_dtc

Product Type: Bond

Product Sub Type: GOV-
AGCY

Template Name: bond_fed

Product Type: Bond

Product Sub Type: GOV-
AGCY

Template Name:
bond_dtc_fed
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Bloomberg Product | Bloomberg Fields Values Calypso Values
DTC_ELIGIBLE Y
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
= US GOVERNMENT Product Sub Type: GOV-BND
SIECURINCIN? T Template Name: bond_fed
TICKER Bond
SECURITY_TYP2 US
COUNTRY_ISO
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
ES US GOVERNMENT Product Sub Type: GOV-BND
SECURITY_TYP T Template Name:
TICKER bond_dtc_fed
Bond
SECURITY_TYP2 US
COUNTRY_ISO v
DTC_ELIGIBLE
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
e US GOVERNMENT Product Sub Type: GOV-NTE
SISGUIRNNCIN? Note Template Name: bond_fed
SECURITY_TYP2
us
COUNTRY_ISO
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
ES US GOVERNMENT Product Sub Type: GOV-NTE
SECURITY_TYP Note Template Name:
SECURITY_TYP2 US bond_dtc_fed
COUNTRY_ISO v
DTC_ELIGIBLE
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
= S|SP|SPX|SPY|SII|BPRN|BCAL Product Sub Type: GOV-
TICKER Bond|Note STRIP
SECURITY_TYP2 . Template Name: bond_fed
Sovereign
INDUSTRY_GROUP
Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond

ES
TICKER

S|SP|SPX|SPY/|SII|BPRN|BCAL

Product Sub Type: GOV-
STRIP
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Bloomberg Product Bloomberg Fields Values Calypso Values
SECURITY_TYP2 Bond|Note Template Name:
INDUSTRY_GROUP | Sovereign bond_dtc_fed
DTC_ELIGIBLE Y

Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
= US GOVERNMENT Product Sub Type: GOV-TIP
SHOHNIEIRA us Template Name: bond_fed
COUNTRY_ISO USD
CRCNY THGTH|WITH|XITII
TICKER

Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
ES US GOVERNMENT Product Sub Type: GOV-TIP-
SECURITY_TYP US BND
COUNTRY_ISO USD Template Name: bond_fed
CRCNY TH[GTH|WITIXITII
TICKER Bond
SECURITY_TYP2

Bond/Govt MARKET_SECTOR_D | Govt Product Type: Bond
e US GOVERNMENT Product Sub Type: GOV-TIP-
SECURITY_TYP US NTE
COUNTRY_ISO USD Template Name: bond_fed
CRCNY TH[GTH|WITH|XITII
TICKER Note
SECURITY_TYP2

BondAssetBacked/ MARKET_SECTOR_D | Govt Product Type:

Govt ES Us BondAssetBacked
SECURITY_TYP DOMESTIC|GLOBAL|DOMESTIC Product Sub Type: GOV-
NAME MTN AGCY
CRCNY SMALL BUSINESS ADMIN Template Name:

USD bondassetbacked_dtc_phy
TICKER
GSBA

BondBrady/Govt MARKET_SECTOR_D | Govt Product Type: BondBrady

=5 Y Product Sub Type: Brady

BRADY

August 2024

Revision 68.0 / Approved
Private and Confidential

Page 52 /128



IOI Nasdaq

Nasdaqg Calypso

Bloomberg DL Products Integration Guide / Version 12.17.0

Bloomberg Product Bloomberg Fields Values Calypso Values
Template Name:
bondbrady_fed
BondBrady/Govt MARKET_SECTOR_D | Govt Product Type: BondBrady
ES Y Product Sub Type: Brady
BRADY Y Template Name:
DTC_ELIGIBLE bondbrady_dtc_fed
BondMMDiscount/ MARKET_SECTOR_D | Govt Product Type:
Govt ES 5 BondMMDiscount
CALC_TYP Product Sub Type: T-Bill
Template Name: M-Mkt T-
Bills
BondAssetBacked/ MARKET_SECTOR_D | Mtge Product Type:
Mtge ES ABS BondAssetBacked
SECURITY_TYP2 Product Sub Type: ABS
Template Name:
bondassetbacked_dtc
BondAssetBacked/ MARKET_SECTOR_D | Mtge Product Type:
Mtge ES . BondAssetBacked
Canadian
SECURITY_TYP Pool Product Sub Type: CDN-MBS
SECURITY_TYP2 Template Name:
bondassetbacked_cdn
BondAssetBacked/ MARKET_SECTOR_D | Mtge Product Type:
Mtge ES CMO BondAssetBacked
SECURITY_TYP2 Product Sub Type: CMO
Template Name:
bondassetbacked_fed
BondAssetBacked/ DELIVERY_TYP DTC Product Type:
Mtge MARKET_SECTOR.D | Mtge BondAssetBacked
ES cMO Product Sub Type: CMO
SECURITY_TYP2 Template Name:
bondassetbacked_fed_dtc
BondAssetBacked/ MARKET_SECTOR_D | Mtge Product Type:
Mtge ES BondAssetBacked

SECURITY_TYP
SECURITY_TYP2

Agncy CMO Z|Agncy CMO
PO|Agncy CMO Other|Agncy

Product Sub Type: CMO-
ACGY
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Bloomberg Product

BondAssetBacked/
Mtge

BondAssetBacked/
Mtge

BondAssetBacked/
Mtge

BondAssetBacked/
Mtge

BondAssetBacked/
Mtge

BondAssetBacked/
Mtge

Bloomberg Fields

DELIVERY_TYP

MARKET_SECTOR_D
ES

SECURITY_TYP
SECURITY_TYP2

MARKET_SECTOR_D
ES

CRNCY
SECURITY_TYP2

MARKET_SECTOR_D
ES

SECURITY_TYP
CRNCY
SECURITY_TYP2

MARKET_SECTOR_D
ES

CRNCY
SECURITY_TYP2
INDUSTRY_GROUP
MARKET_SECTOR_D
ES

CRNCY
SECURITY_TYP2
INDUSTRY_GROUP
MARKET_SECTOR_D
ES

CRNCY

Values

CMO I0|Agncy CMO INV|Agncy
CMO FLT

CMO

DTC
Mtge

Agncy CMO Z|Agncy CMO
PO|Agncy CMO Other|Agncy
CMO I0|Agncy CMO INV|Agncy
CMO FLT

CMO

Mtge
uSsDh

Pool

Mtge
SBA POOL
UsSbD

Pool

Mtge
Usb
Pool|Whole Loan WL Collateral
CMO

Mtge
uSD

Pool|Whole Loan Agency
Collateral

CMO
Muni
UusbD

Calypso Values

Template Name:
bondassetbacked_fed

Product Type:
BondAssetBacked

Product Sub Type: CMO-
ACGY

Template Name:
bondassetback

Product Type:
BondAssetBacked

Product Sub Type: GOV-
ACGY

Template Name:
bondassetback
Product Type:
BondAssetBacked

Product Sub Type: GOV-
ACGY

Template Name:
bondassetback
Product Type:
BondAssetBacked
Product Sub Type: MBS

Template Name:
bondassetback

Product Type:
BondAssetBacked

Product Sub Type: MBS

Template Name:
bondassetback

Product Type: Bond
Product Sub Type: MUNI
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Bloomberg Product Bloomberg Fields Values Calypso Values

Template Name:
bond_phy_mun

BondAssetBacked/ MARKET_SECTOR_D | Muni Product Type: Bond
Mg Ee USD Product Sub Type: MUNI
CRNCY Y Template Name:
DTC_ELIGIBLE bond_dtc_muni
BondMMDiscount/ MARKET_SECTOR_D | M-Mkt Product Type:
M-Mkt ES 6|4 BondMMDiscount
CALC_TYP Product Sub Type: Discount
Template Name: M-Mkt
Discount

Product Code Wildcard Mapping

Fields used in Product Code mapping support the single quantifier of X* for purposes of wildcard mapping.
Examples include:

Expression Description Example No Match
PATTERN{'x*} Ending Wildcard | PATTERN{G2RM*} G2RM, G2RM G1RM, FNARM,
7.3, G2RM 6.9 G2SF 3
PATTERN{*x} Leading wildcard | PATTERN{*RM} G2RM G2RM 7.3, G2RM
6.9
PATTERN{*'x"*} Contains PATTERN{*RM*} G2RM, G2RM G2SF 3
wildcard 7.3, G2RM 6.9,
RMBS 1.9
PATTERN {'x"*} | {'x"*} Or expression PATTERN{G2RM*} | G2RM, G2RM G1RM
will match either | PATTERN{G2SF*} 7.3, G2RM 6.9,
case G2SF 3

Pattern class mapping can be utilized to map a single template to a wider range identifier using the wildcard:
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£\ Bloomberg Mapping Window — O X
E Bloomberg Mappings 4 Bloamberg Mapping
- [ Bloomberg Values r
-- [F] DayCounts - Yields - EOM Name Value Select
= Products MARKET _SECTOR_DES Mtge ]
-7 Corp MTG_COLLAT_TYP PATTERN{GZRM=}
[ Govt COLLAT_TYP |
- Mtge SECURITY_TYP ]
- 4% BondAssetBacked/ABS SECURITY_DES
- 4% BondAssetBacked/ABS COUNTRY_ISO
- 4% BondAssetBacked/ABS CALC_TYP
- 4% BondAssetBacked/ABS CRNCY
- 4* BondAssetBacked/ABS CPN_TYP
- 4* BondAssetBacked/ABS SECURITY_TYPZ
- 4% BondAssetBacked/ABS RESET_IDX
- 4% BondAssetBacked/ABS ISSUER.
- 4* BondAssetBacked/ABS
= ¥rondAssetBacked REVERSE_MTGE
-5 Muni

Calypso Values
Product Type Product Sub Type

BondAssetBacked ~ REVERSE_MTGE ~
Template Name

REV_MORT -

3.2.13 Defining Bond Subtype Classifications in Calypso

The Bond subtypes must be defined in the domain “Bond.subtype.” Each organization must define its own subtypes
grouping. Below are examples of common subtypes.

The Generic subtype is pre-defined and captures unmapped bonds.

[ Domain Values Window o ]

Search:l Find ||_ Yalue :

5] Band.subtype o] Mame: IBond.subtype
# AID

i fgency == Walue: IGeneric

# ETAM
4% BTPS Comment: IGeneric Bond

# Bund
A
; 221[') <« Add | Sawve Above |
i
& C65 == Remove |
4% Canada Agency
i Canada Govt Constraints |
4% Canada Prov
o i® Canadas Help |

4% Corporate
i ESP

4% Exatic
4% FRN

}. Gilk
2 INFLATION
4% Indexed -
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I Domain Values Window 1Ol x|
Search: I Find ||- Yalue :
[~ Bond. subkype A Tame: IBondAssetBacked.subtype

lj BondAssetBackﬁd.collateraITypE_l

lj BondassetBacked. poolFactorTyp
ondassetBacked, Pricer

4 ABS
A% ARM
4* ALUDMBS
A% Cap
4F CAD-MBS
A% Can
A oMo

il 4% Canardian I _blj

iommenk: I

<= Add |
== Remove |
Zonstrainks |
Help |

Yalue: I

Save Above |

1j BondFRM.subkype
1j BondHolding, Pricer
=l {] BondMMDiscount Pricer

i

+1-1 Bond
-] BondMMDiscountALD, subkype
-7 BondMMiInterest, Pricer
-7 BondMMInterest, subtype
-] BondOption, Pricer

-] BondOption, subtype

J EBandRevalver subtype _ILI
I ’

4

il

I Domain Values Window o =]
Search: IBondMM Find ||_ value 4
[+ (] BondFRM. Pricer ;I Name: IBondMMDiscount.subtype

Walue: IDiscount

Comment: I

<< Add
= Remaove
Constraints

Help

Save Above |

In addition, define subtypes (e.g., Generic, Standard, etc.) for the following bonds:

e BondBrady.subtype
e BondCLN.subtype
e BondFRN.subtype

3.2.14 Custom Column Request List

You can specify your own custom list of columns to be requested.

Choose Utilities > Bloomberg My Mapping to open the My Mappings window.
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A

Available

Selected

ICRNCY

[cPN_FREQ
(CPN_TYP

ICUR_CPN
ICV_CNVS_PX

lCV_COMMON_ISIN
lCV_START DT

lCV_UNDERLYING _ID_BE_UNIQUE
ICV_UNTIL

DAY_CNT

DAY_CNT_DES

| DAY_PAYER_FREQ
DAYS_TO_SETTLE

| DELIVERY_TYP
DELIVERY_TYP_LIST
DES_CASH_FLOW

| |DES_NOTES

| lprc e

oo

IGIELE

DVD_CRNCY
DVD_DECLARED_DT
DVD_EX_DT

o

®e

® ®

AMT_ISSUED
ANNOUNCE_DT
BASE_ACC_RT_DT
BASE_CPI

BRADY

BULLET
BVOL_DATA_TIME_STAMP
BVOL_IBOR_CAP
BVOL_TBOR _SWAPTION
BVOL_OIS_CAP
BVOL_OIS_SWAPTION
CALC_MATURITY
CALC_TYP
CALC_TYP_DES
CALENDAR_CODE
CALL_BUS_DAYS_IND
CALL_DAYS_NOTICE
CALL_FEATURE
CALL_SCHEDULE
CALLABLE

CALLED_DT

MDD EOEQ CRKE WD

e ©e9

Only the columns added on the right will be requested. These columns will not be overwritten by running Execute

SQL

In most cases, Templates are used to provide default data that Bloomberg does not provide. But in some

3.2.15

RFR Template Override

conditions Templates may be needed to override the incoming data sent by Bloomberg. This can be common for a

newer product where the data model is evolving such as the LIBOR Replacement RFR Bond Market.

The Bloomberg Reset Index Value must be defined in this RFR Template Override to allow Template override. The
Calypso Value only needs to be a descriptor not the actual Calypso Value.

As

loemberg Mapping Window

=-E

& MBS e Lnange rreg
1[I PricingSource

- 4% PricingSource.BGN

[ PricingSource BVAL
RFRTemplateOverride
(.42 RBACOR

i

4* SOFRRATE

4% SOMIOMN

t-[] ResetIndex

- [ SECID

t-[7] SecCodes

- [] SwaptionCurrencies

i [] TradeAmendRecordTypes
#- [ TradeCancelRecordTypes

E
£
E
[
£
£
£

- [] TradeMewRecordTypes

F#-[] DayCounts - Yields - EOM
- Products

Load

- O b
~| 4
M

Mame: RFRTemplateCverride

Bloomberg Value: SOFR304A

Desc / Calypso Value; SCOFR 30 Day AVG Index

<< Add
> Remove
v
Close

[NOTE: Items set for this mapping only override the incoming Bloomberg value, each Reset Index still
needs to be defined in the Reset (Reference) Index Mapping.]
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3.2.16 RFRFlipper Bonds

This only applies to Fixed to Floating flipper bonds. The history of the Flipper is maintained only when the existing
Flipper is in LIBOR flipper and the user imports an RFR flipper. The system performs the following actions:

Existing Imported Action

Flipper Flipper

LIBOR LIBOR Remove existing flipper and add imported Flipper

LIBOR RFR Retain existing Flipper and add imported Flipper

RFR RFR Remove existing flipper and add the imported Flipper

RFR LIBOR UnsupportedException is generated "Unsupported import- existing bond has RFR
flipper index but import has LIBOR”.

3.3 Using Bloomberg Connect

Products can be imported one at a time, multiply, or in bulk using an import file that contains a list of tickers.

3.3.1 Single or Multiple Requests

Prior to requesting a Bloomberg file, you need to start the Bloomberg engine, which communicates with Bloomberg
(i.e., sending the Request file and retrieving the Result file).

The following characters are not used in the Value field:
e :(Colon)

e *(Asterisk)

e ? (Question Mark)

e < (Left Angle Bracket)

e > (Right Angle Bracket)

e \ (Reverse Solidus)

e | (Bar)

e " (Double Quote)

The Bloomberg engine can be started from the Engine Manager in Web Admin.

P Please refer to Calypso Web Admin documentation for complete details.

3.3.2 Requesting an Individual Product

»  Select a Security Code or Market Sector.

» Enter a Value that identifies the security. Click Add.
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»  Click Submit Request.

3.3.3 Requesting Multiple Products

There are two methods to enter requests for multiple products: By manually adding multiple securities, or by using
the Add From File functionality.

Manual Method

~

»  Select a Security Code or Market Sector.
»  Enter a Value that identifies the security. Click Add.

» Repeat until you have added the desired securities.

~

> Click Submit Request.

Add From File Method

» To add products in bluk, enter them in a file having the following format:
# Note - Users must provide identifiers with Security

# Code and/or Market Sector. If all of the identifiers have
# the same Security Code and/or Market Sector then the value
# for Security Code and/or Market Sector need only be

# specified once. Lines beginning with # or ! are comments.
#

#

# Start of Data

Market Sector=Equity

Product Code=

#Column heading
# Identifier SecurityCode MarketSector
GM
©
IBM
HBC
MS
WEC
The example file shown above requests six products whose Market Sector is Equity. Therefore, only the

product ID is required for each entry. The example below shows another request for six products. However, in
this example, the Security codes are not identical and must be given:
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#
# Start of Data
Market Sector=

Product Code=

#Column heading

# Identifier SecurityCode

31393u2a0 CUSIP
X50220953235 ISIN
Xs0307485903 ISIN
Xs02209532 ISIN

X503074859 ISIN

MarketSector

»  Click Add From File to open the file browser:

Look in: IE) Calypso

My Documents

[ N A==

= FAR_LEG_QUICK_PANEL
= FX_DEAL_CAPTURE_VIEW
) NEAR_LEG_QUICK_PANEL
I3) alba

() amag

I3 bloomberg

[Z] Activity_treelayout txt

[Z] doct_treelayout txt

[Z] Document txt

‘8 Equitylnput.txt

[Z] lastremembered txt

[Z] SampleBaondinput.txt

File name: |Equity1nput.txt

Files of type: IInput Files {.txt)

Open

LI Cancel |

»

Select the file containing the desired products, then click Open to populate the Selections table:
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A BloombergConnec — O x
Utilities
Request Import From File
Selections
Sector: | Equity — Equity ~ | Security Code:  CUSIP ~ | Value: Add
Feed: ~
Sector Security Code Value PrepaymentType PrepaymentValue
Equity 31393U2A0 CUsSIP
Equity X50220953235 ISIN
Equity X50307485903 ISIN
Equity X502209532 ISIN
Equity X503074859 ISIN
Add From File...
3.34 Import From File
=lolx
Utilities
Request (T |
Bloomberg File: I Impatt

»  Select a file.

»  Click Import to begin the import process. The Bloomberg Connect log displays the created products as
shown below.

The format of the file must be consistent with that generated in the individual requests.

Import from File is generally used for migration. The file is manually requested directly through the Bloomberg’s
“Bloomberg Data License Request Builder Window.”

3.3.5

Bloomberg Connect Response

Bloomberg Connect displays four messages while processing your request:

e Request_CREATED — Your request file has been created.

e Request_SENT — Your request file was transmitted to Bloomberg.
e Request_BEING_PROCESS — Bloomberg has acknowledged the request and is gathering data.
e Reply_RECEIVED — Calypso has received the Bloomberg response file.

Parameters
Configuration:

Events

vl o [] cashflow update only

PSEventBloomberg: REQUEST_CREATED
PSEventBloomberg: REQUEST _SENT, _fileName=mac_IBM
PSEventBloomberg: REQUEST_BEING_PROCESS, _fileName=mac_IEM, _code=oneshot, _value=getdata
PSEventBloomberg: REPLY_RECEIVED, _fileMame=mac_IEM, _code=oneshot, _value=getdata

Submit Request

Clear
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The request file is placed in the location specified by BLOOMBERG_LOCAL_DIR.
When the Reply_RECEIVED Message is displayed, the application has saved the security in your database.

The events are generated by the Bloomberg engine. The log of the Bloomberg engine gives you event status
information.

The Task Station will provide information about each requested security, such as whether the product was found
on Bloomberg, which curves were created (if any). You can monitor the result of this activity in the Task Station.

3.4 Source-Specific Pricing

Clients can request source-specific pricing information using the PRICING_SOURCE entry in the header of their
Request file. If pricing information from a specific source is not available, Bloomberg returns the default pricing
information for the requested securities unless Exclusive Pricing Source is specified or the
EXCLUSIVE_PRICING_SRC header entry is present.

Entries for Pricing Source are populated from PricingSource entries on the Bloomberg Mapping window. The
Snapshot times are populated from the Bloomberg Values specified by entries for each
PricingSource.SOURCENAME domain value (example PricingSource.BVAL).

Calypso is pre-configured with the BVAL and BGN PricingSources. The Bloomberg Value entries under each
PricingSource.SOURCENAME specify the available snapshot times used to populate the Snapshot field on
Bloomberg Update.

The following image shows the out-of-the-box entries for BVAL:

- O e

¥ BGN
4¥ BVAL
42 PricingSource.BGN

= _‘I PricingSource .BVAL
LO12PM
LO3PM
LO4PM
NY3PM
NY4PM
TO3PM
TO4PM

Ve Ve Vo Ve Vo Vo s T

3.41 Manually Request Source-Specific Pricing

To request pricing from a specific source, add PRICING SOURCE=source name t0 the Request file header. For
example, PRICING SOURCE=MLIX.
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To request snapshot pricing from a source supporting BVAL data, add
PRICING SOURCE=source name:source time t0 the Request file header. For example,
PRICING SOURCE=BVAL:NY3PM.

If pricing is not available from a specified source, then data from the default pricing source is provided. To restrict
the delivered pricing to the specified source, add the EXCLUSIVE_PRICING_SRC header to the Request file.

3.4.2 Using Bloomberg Update to Request Source-Specific Pricing

Using the Quote Template for getdata, gethistory, or getsnap programs, the Bloomberg Update window displays
the Exclusive Pricing Source button, and the Pricing Source and Snapshot dropdown selectors.

To request a specific source, choose a source from the Pricing Source dropdown selector and a Snapshot time (if
the source supports BVAL data). If pricing is not available from a specified source, then data from the default
pricing source is provided. To restrict the delivered pricing to the specified source, select Exclusive Pricing Source
(adds the EXCLUSIVE_PRICING_SRC header).

When specifying a Pricing Source, Calypso adds your selections to the Request file as the PRICING_SOURCE
header entry (see Manually Request Source-Specific Pricing for PRICING_SOURCE examples).
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4 Bloomberg Update Window

Using the Bloomberg Update window, you can define an Update Template to use with one-shot requests or
requests made with scheduled tasks.

For bonds, one of the following identifiers is required: ID_CUSIP, ID_ISIN, or ID_BB.

For equities, one of the following identifiers is required: ID_CUSIP, ID_ISIN, ID_BB, TICKER_AND_EXCH_CODE, or
TICKER.

From the Bloomberg Connect window, choose Utilities > Bloomberg Update to open the Bloomberg Update
window.

£ Bloomberg Update - O ¢
j Bloomberg Updates : Update Definition
=+ oneshot Program: |gethistory w Template Type: |Quote
- 4% BYOLEUR-CF-LN
- 4% BYOLUSD-CF-LN Mame: |IBOR_35D Template Mame | BloombergDLMEW e
- 4% EUR3MSYWAFTION
- . '
. 4% EURGMSWAPTION Frequency: |oneshot w Run Date: (MYYMMOD)
-4 FX Period: | daily e Exec Time: {HHMM)
- 4% TBOR
- 4% TBOR_100D Currency: |ANY e Date Range: |-350 D (YYYYMMDD) / Tenor
- 4% TBOR_195D -
- = Pricing Source: e Snapshot:
W R E0R. 350 o :
- 4# TBOR_Fallback Exdusive Pricing Source
-1 weekdy

Add Custom Header

Feed: w

» You can click Lead to load templates that are already defined in the Bloomberg Updates area. Then select a
template to view its details.

» To create or modify a template, enter the fields described below as needed, and click Save to save your

changes.
Fields Details
Item Description
Program Select from the following Bloomberg Requests:
e (getdata - Retrieves Bloomberg data for requested products.
e gethistory - Retrieves historical data for requested products.
e (getactions - Retrieves Corporate Actions for requested products.
e getshap — Retrieves a Quotes snapshot for requested products.
e cancel - Cancels a scheduled job by name.
Name The name of this update template.
Frequency The nominal frequency of use for this update template. Choose from:
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Item Description

Add Custom
Header

Feed

Show Bond Prepay
Detail

Prepay Type
Prepay Speed
Edit Prepayment

Template Type

Template Name

Run Date

Exec Time

e adhoc - Used for one-off requests (for master data accounts only).

e oneshot - Used for one-off requests (for non-master data accounts), or scheduled
requests for master data accounts (should be sent 15 minutes prior to processing).

e daily - Runs every day

e weekly - Runs once a week

e monthly - Runs once a month

e weekday - Runs each working day (by locale)

e weekend - Runs each day of the weekend (by locale)

To add custom headers.

P See Custom Headers for details.

You can select a feed config if you are using multiple user accounts. Otherwise,
BLOOMBERG_STP_USER is used.

P See Feed Configuration for details.

To override the prepayment details.
P See Bond MBS External Cash Flows for details.
getdata for Bond only.

The product type that this update template requests. For Getdata and Getactions:
° Bond

o Equity
o Equity Index
e Quote

For Gethistory and Getsnap:

e Quote

The name of the product template used with this update template.

Click ... to open the template selected in Template Name for editing, or to open a blank
Selected Template window where the user can create a new Product Template.

Available only for Bond and Equity template types.
Enter a date for this update to run.
The time to execute this update template when run as a scheduled task. Also used by the

Getactions, Getdata, Gethistory, and Getsnap programs as SNAPTIME or TIME header
options.
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Item Description

Columns The list of Columns to retrieve with this update template. Right click the column header and
click on Configure Update Columns to launch the Update Columns Selector.

Period Choose from:

o Daily

o Weekly
e Monthly
e Quarterly
o Yearly

gethistory only.

Currency Choose from Any to retrieve available data for all currencies, or choose a specific currency.

gethistory only.

Actions Select the type of corporate action data to retrieve:
o All

e Distributions

e Capital Change

e Corporate Events

e Stock Split

e (Cash Dividend

e Stock Dividend

o Merger

e Spin-off

getactions only. Default = All.

Action Date Select the Action Date to use:

e Effective Date
e Entry Date
e Both

getactions only. Default = Effective.

Date Range Enter the starting and ending date range for data retrieval.

gethistory and getactions only.

The Date Range field in the Bloomberg Update window provides user to enter generic
tenors in the date range. For example, 35D to 0D, 100D to 0D, 195D to OD

Delay Limit Requires Bloomberg to produce reply file within the specified number of minutes; securities
with longer embargoes are not included in the response and reply files.
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Item Description

Exclusive Pricing
Source

Pricing Source

Snapshot

e NY3PM
e NY4PM
e LO3PM
e LO4PM
e LO12PM
e TO3PM
e TO4PM

getsnap only.
Select this option to require Bloomberg to return either source-specific pricing information
or BVAL pricing information.

Selecting Exclusive Pricing Source enables the Pricing Source and Snapshot dropdown
selectors, which are used to select pricing sources and snapshot times.

Selecting Exclusive Pricing Source also causes Calypso to add the PRICING_SOURCE and
EXCLUSIVE_PRICING_SRC (always used with PRICING_SOURCE) headers to the Request
file.

getdata, gethistory and getsnap only.

The Snapshot dropdown selector is enabled when by selecting Exclusive Pricing Source.
Select the pricing source for this request.

getdata, gethistory and getsnap only.

The Snapshot dropdown selector is enabled when by selecting Exclusive Pricing Source.

Select the source/time for your BVAL/BGN pricing. By default, Calypso provides the
following options out of the box:

(NY at 3 and 4 PM, London at 3, 4, and 12PM, and Tokyo at 3 and 4 PM.)

Additional snapshot times are determined by the Bloomberg Values specified for
PricingSource.SOURCENAME.

getdata, gethistory and getsnap only.

Cancelling Periodic Requests

You can use the Cancel program to remove (i.e., cancel) periodic (daily, weekly, etc.) requests. Cancel does not

work with oneshots.
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4.1 Terminal User Properties

The request files for all existing programs include the optional Terminal User Properties, if the user has set them in
the environment properties. If you do not wish to send any terminal user information, simply unset the properties.

[NOTE: You may need to supply some or all of these properties to access different terminal user
functionality in Bloomberg.]

The following environment properties support terminal user designation.

Field Environment Property

SN BLOOMBERG_SN

WS BLOOMBERG_WS

USERNUMBER BLOOMBERG_USERNUMBER
4.2 Server Timezone Property

This system environment property is set by the administrator in calypso.system.properites.env name.
BLOOMBERG_SERVERTZ is used by the Getsnap program as the SNAPTIME header option and by the Getactions,
Getdata, and Gethistory programs as the TIME header option.

The application converts the local Exec Time from the Bloomberg Update window to the Data License Server
timezone specified by the BLOOMBERG_SERVERTZ environment property.

The converted time is used as either the SNAPTIME or TIME sent in the request file. SNAPTIME is the time that the
Bloomberg Data License Server will take the pricing snapshot. TIME is the time that the Bloomberg Data License
Server will pull the requested information for Getactions, Getdata, or Gethistory.

If BLOOMBERG_SERVERTZ is not set, the application sets SNAPTIME or TIME equal to the Exec Time.
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5 Custom Headers

Custom headers allow supporting additional properties.

Custom headers can be added in the domain “BloombergCustomHeader”.

A Domain Values

" Reload [ Save [ Save Al | [#%] Constraints Setup

(1~ BloombergCustomHeader 1of 1@ @ | [Jvalug
- Mame: |BloombergCustomHeader
=[] BloombergCustomHeader ~

L4 Value: |IFRSSPPI

i -4 CREDITRISK )
H . Comment: |true
[T EloombergFITCalypsoMapping, Types

You can click Add Custom Header from the Bloomberg Connect window or the Bloomberg Update window.

Add Custom Header |

| Parameters
Submit Request

Configuration: - [[] Cashfiow update anly
A Bloomberg Update
T Bloomberg Updates |4 Update Definition
Program: | getdata W Template Type: | Equi
Name: Template Name | TES
Frequency: |daily P Run Date:
Add Custom Header [EEEmE:
Feed: ~

It opens the Add Custom Header window.

| £ Add Custom Header - O X
Header — e Value

[FRS95PPI ustern Header |ves

CREDITRISK Delete Custern Header |\,ES

Save Cancel

»  Right-click the Header heading and select Add Custom Header.
» Add header and a value as needed.

» Repeat as needed.
When done from the Bloomberg Connect Window, these headers are transient and not stored in the database.

When done from the Bloomberg Update Window, these headers are stored in the database with respect to the
corresponding update.
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6 Equity Product

6.1 Equity Identifier Lookup Priority

Equities are uniquely identified by one or more Bloomberg identifiers: ID_CUSIP, ID_ISIN, ID_BB,
TICKER_AND_EXCH_CODE, and TICKER. Calypso stores these values when present.

When Calypso processes a request file, it looks for an Equity using each of the identifiers in this order: ID_CUSIP,
ID_ISIN, ID_BB, and TICKER_AND_EXCH_CODE, and TICKER.

TICKER_AND_EXCH_CODE is mandatory, irrespective of ID_BB / ID_CUSIP / ID_ISIN / TICKER.

If the equity already exists, it will not be renamed.

6.2 Equity Naming Convention

Calypso uses the value of the Bloomberg TICKER_AND_EXCH_CODE column as the default equity name when
populating the TICKER_UNIQUE field. You must use TICKER_AND_EXCH_CODE when loading equities. Calypso will
populate this column when a new equity is retrieved and when updating existing equities.

For example, for IBM, the equity name is “Equity.IBM US.”

You may request a product using TICKER or TICKER_UNIQUE. When using TICKER_UNIQUE, you must request the
equity using the entire name (e.qg., IBM US). When using TICKER (e.g., IBM), because TICKER is not unique and
because a security might not use TICKER, Bloomberg may return incorrect, multiple, or zero records.

Scheduled Task queries always reference TICKER_UNIQUE to ensure that the proper security is returned.

6.3 GBp vs GBP Dividend Amounts

Certain equities report their dividends in GBp (Pence). When the application receives a Dividend Currency of “GBp,”
Calypso now divides the dividend amount by 100 and reports the price in GBP.
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/  Equity Index Product

When requesting an Equity Index, the application will create (or update) the product, create the Volatility Surface,
and perform a Dividend Yield mapping.

7.1 Equity Index Identifier Lookup Priority

Calypso performs Equity Index lookup using the Market Sector and Ticker. For example, a request for the S&P 500
INDEX (SPX) will appear as shown below.

A BloombergConnect - O pd
Utilities
Request Import From File
Selections
Sector:  Index — Index ~ | Security Code: = Value: Add
Feed: e
Sector Security Code Value PrepaymentType PrepaymentValue
Index - Index | [sPx | |
7.2 Equity Index Naming Convention

Equity Index names follow the same convention as Equities.

7.3 Equity Index Update Results

From the information returned by Bloomberg, populates the following fields for an Equity Index:

Field Environment Property Description
Name TICKER, then SECURITY_DES then Equity Index names follow the same
ID_BB convention as Equities.
Currency CRNCY
Country COUNTRY The country of the Index.
Publish Holiday Derived The Holiday Calendar of the Currency.
Publish Frequency Calypso populates this field with “DLY.”
QuoteType “Price”
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Field Environment Property Description

Index Type “Equity” All Indexes are presumed Equity.

Description NAME The Index’s long name.

DateRaoll Calypso populates this field with
“FOLLOWING".

CODES TICKER

BB_UNIQUE_ID Ticker CUSIP and ISIN are not available.

Issuer

Basket Not appropriate for initial creation.

[NOTE: Calypso only updates those Equity Index fields that are mapped.]

7.4 Equity Index Constituents

To import Equity Index constituents, you need to set the environment property
BLOOMBERG_CREATE_INDEX_CONSTITUENTS=true, otherwise, only the Equity Index Definition will be imported.

You need to run the BLOOMBERG_UPDATE scheduled task twice: first to create / update the equity index with
dummy assets, then to import the constituents.

7.41 Equity Index Definitions
Make sure that you have created an Equity Report template.

Create a Bloomberg Update definition with “Update Index Constituents Only” not checked:

A

3 Bloomberg Updates : Update Definition

=[] oneshot Program: getdata ~ Template Type: Equityndex

42 UpEquities
:---.' Name: UpdateIndex Template Name | NikkelTemplate ~
Frequency: oneshot ~ Run Date: (YYYYMMDD)
Add Custom Header Exec Time: ()
Feed: — ["] update Index Constituents Only
Columns
Name Type
MARKET_SECTOR_DES Update - No Task
SECURITY_TYP Update - No Task
TICKER Update - No Task
SECURITY_NAME Update - No Task
NAME Update - No Task
CRNCY Update - No Task
COUNTRY_ISO Update - No Task
FEED_SOQOURCE Update - No Task
INDX_DIVISOR Update - No Task
INDX_MEMBERS Update - No Task
INDX_MWEIGHT Update - No Task
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Run the scheduled task BLOOMBERG_UPDATE to create / update the Equity Indices.

Attribute Value

Action 1 - Send Reguest for Updates
DIFFFLAG

Update Names

Input Dir

Input Files UpdateIndex

Attribute Value
Action 2 - Process Updates Received
DIFFFLAG
Update MNamas
Input Dir
Input Files UpdateIndex

7.4.2 Constituents

Create a Bloomberg Update definition with “Update Index Constituents Only” checked:

A Bloomberg Update — O X
Fﬂ Bloomberg Updates |4  Update Definition
=+ oneshot Program: | getdata ~ Template Type: |Equityndex ~
Yo guites) grarm: |9 plate Type: 01
4% UpdateIndex Name: |UpEquities Template Name | NikkeiTemplate v
Frequency: |oneshot - Run Date: (YMMDD)
Add Custom Header Exec Time: (HHMM)
Feed: — Update Index Constituents Only
Columns
Name Type
MARKET_SECTOR_DES - Update - Mo Task
SECURITY_TYP - Update - No Task
TICKER - Update - No Task
TICKER_AND_EXCH_CODE ~ Update - No Task
ID_BB_UNIQUE ~ Update - No Task
NAME ~ Update - No Task
CNTRY_ISSUE_ISO - Update - Mo Task
ISSUER - Update - No Task
CRNCY ~ Update - No Task

Run the scheduled task BLOOMBERG_UPDATE to import the constituents:

Atfribute Value

Action 1 - Send Request for Updates
DIFFFLAG

Update MNames

Input Dir

Input Files |UpdEquities

Attribute Value
Action 2 - Process Updates Received
DIFFFLAG
Update Mames
Input Dir
Input Files UpdEquities
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8 Bond Product

8.1 Bond Notes

8.1.1 When Updating Bond Definitions

To update the issuer information, then you must also include the ISSUER and TICKER fields in the Bloomberg
Update definition.

To update the security, but not the issuer information, use either ISSUER or TICKER, but not both. Issuer
information is only updated if both are present.
8.1.2 When Creating Bond Definitions

To create Bonds, ensure that the ISSUER and TICKER fields are included in the requested fields, by default these
fields are included unless explicitly removed from the list of COLUMNS. The list of columns can be viewed on the
Bloomberg Mapping window’s Bloomberg Values Columns.

8.1.3 Unique Identifiers

At least one of the following unique identifiers must be given for a Bloomberg bond to be able to be saved:

e CUSIP
e [SIN
e BB

e TICKER_UNIQUE
o |D_BB_GLOBAL

Note that the BB_GLOBAL product code also needs to be created manually as it is the Calypso value to which the
Bloomberg value is mapped.

4 Product Code naow - O *
Name |BB_GLOBAL b ... Type string e
Unique (Securities Only) [ mandatory {Securities Only)
Searchable Jotc
Product |ALL
Mame Type Unique Searchable Mandatory OTC  Product List |
BB_CALC_TYP Jint [false  Jtrue |false [false [Bond ~
BE_DTC_ELIGIBLE string  [false true false false |Bond |
BB_ID_BB_ULTIMATE_PARENT_CO_NAME |string |false true false false |Bond
BE_ID_BB_UNIQUE string  [false true false false |Bond,Equity
BB_IS_SECURED string  [false true false false |Bond
BB_IS_SUBORDINATED string  |false true false false |Bond
BB_LINKED_BONDS_INFO string  [false true false false |ALL
BE_MARKET_SECTOR_DES string  [false true false false |ALL W
- S — - = =
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i~

¥ FUT_HAS_CTD

4 GICS_INDUSTRY_GROUP_NAME
& GICS_INDUSTRY_NAME

¥ GICS_SECTOR_NAME

4 GICS_SUB_INDUSTRY_NAME
4 GUARANTOR

& HIST_CASH_FLOW

& 1C8_INDUSTRY_MAME

Namie: Colurnns
Bloamberg Value: ID_BB_GLOBAL

Desc { Calypso Value: CODE#BS_GLOBAL

4¥ 1C8_SECTOR_NAME << Add
¥ ICB_SUBSECTOR_NAME
4 ICH_SUPERSECTOR_NAME >> Remove
2 m_Be
£ ID_BE_COMPANY
2
& D_BE_SECURITY
.
8.1.4 Sink Schedules

N

& CNTRY_OF_RISK

& DTC_ELIGIBLE

¥ GICS_INDUSTRY_GROUP_MAME
& GICS_INDUSTRY_NAME

& GICS_SECTOR_MAME

¥ GICS_SUB_IMDUSTRY_NAME
4 ICB_INDUSTRY_NAME

& ICB_SECTOR_NAME

i 3CE_SUBSECTOR_NAME

4* ICB_SUPERSECTOR_NAME

& ID_B8

..'

4 I_BB_ULTIMATE_PARENT_CO_NAME
& ID_BB_UNIQUE

2 ID_COMMON

Name: SecCodes
Bloomberg Value: ID_BE_GLOBAL

IDesc | Calypso Value: BB_GLOBAL

<< Add

>> Remove

When requesting the SINKABLE field, if the returned value is Y, Calypso will create a Sink Schedule for most bonds.

Calypso does not create a sink schedule for Small Business Administration (ticker GSBA) bonds.

For municipal bonds, Calypso will create a Sink Schedules when the redemption method is Pro Rata or when

SINKABLE is Y.

8.2 Bond Naming Convention

By default, Calypso creates bond names from Bloomberg using either SECURITY_DES, TICKER, or ID_BB_UNIQUE, if

available, in that order.

For instances where SECURITY_DES is not unique (e.g., Series bonds), it is possible to use Bloomberg mapping to
create the bond name using different fields.

8.3 Setting a Template

Several criteria can be used to isolate the population of securities to be updated.

From the Bloomberg Update window, you can edit an existing template or create a new one. To edit an existing
template, select the Template Type and Template Name, then click the ellipse to launch the Selected Template
window. To create a new template, select a Template Type and then click the ellipse.

e Variables bonds
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z Bond Report (5/8/06 1:32:42 PM) User: calypso_user{BondVariable]

wmmmmmmw

Class [ IN

Type [V IN
Currency [V IN
Industry [V IN
Status [V IN
Country [V IN
Tssoar [7 IN

In Invertory of Book [V IN
Coupon Type [v IN

6 (*) | Speciic Securities | Sec Codes Fiker | Issuer Attributes Fiter |

fpond

[VERIFIED

I

}vaiabla

Mortgage and Bond Asset Backed
I Bond Report (5/8/06 1:32:42 PM) User: calypso_user{BondAssetiiacked)

mmmmmmmm

SRR

Class [ 1N

Type v IN
Qurrency [V IN
Industry [V IN
Status [V IN
Country [V IN
Isson [7 IN

In Inventory of Book [V IN
Coupon Typs [V IN

All Bonds

ver (%) | Specic Securities | Sec Codes Fiter (*) | Tssuer Attributes Fiker |

[BondassetBacked

B EEE

|
|
[VERIFIED
|
|
|
I

et

P Selected Template [all_bonds] - Please Edit Criteria and sa

Report Data “iew Export Bond Report  Uhtilities

Help

‘f;| = |Close

Properties Filter I specific Securities | Sec Codss Filker | Issuer Attributes Filker |

Class [

—_

M
Type [V In

Currency v IN

=

Industry v IM
Status v IN

—

Country [ IN

Issuer v IN

=

In Inventory of Book [+ IM

Coupon Type v IN
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8.4 Defining Bond Updates

8.4.1 Variable Coupon
BLOOMBERG_VAR_COUPON_SCHEDULE, which must be TRUE to accept updates.

e Applicable Market Sectors: Govt, Corp, Muni.
e Applicable to Floaters (i.e., RESET_IDX not null).

During creation, the coupon history for Floaters and Variable Schedule for Govt, Corp, Muni use the
FLOATER_ACC_SCHEDULE field. This is not applicable to Mtge.

For the updates, the fields CUR_CPN and BASE_ACC_RT_DT provide the most current data once the index resets.

o
63 Bloomberg Updates : Update Defintion 1
El er%m Name Template Based Update
> AKDY CURC
* WKDY_FACTCPN JWKEY_CURCPN [Bondveriabie P _I
1% WKDY_FACTGSBA S EdseTha (REW). R Doks CVVYSO)
12 WKDY_INDEX 2 )
4 WKDY_PRICES |weskday ) [
Columns
Name Type
MARKET_SECTOR_DES < o Update - Create Task
10_68_UNIQUE ~ No Update - Create Task
10_CusIP ~ No Update - Create Task
D_ISIN |~ Mo Update - Create Tosk.
CUR_CPY ~ Mo Update - Create Task
BASE_ACC_RT_DT ~ No Update - Create Task

8.4.2 Variable Schedules
The field STRUCTURED_NOTE_CPN_FORMULA is used to get the coupon formula for variable spread bonds.

| A
| 4 SECURITY_NAME ~ld

| i SECURITY_TYP N ame: =

t i SECURITY_TYP2 it il
¥ SERIES

Bloomberg Value: | STRUCTURED_NOTE_CPN_FORMULA

4 SETTLEOT SRR Eaad
& SINKABLE Dasc [ Calypso Valua: __spreadSchedule
& SINK_FUND_REDEMP_METHOD
42 SINK_SCHEDULE
4 SP_EFF_OT << Add
& STEPUP_CPN
& STEPUP_CFN_SCHEDULE >> Remove

4 STEPUP DT
A STRUCTURED NOTE_CPN_FORMULA|
& TICKER

In order to get data on this field you need to add the header SKIP_PCS=BVAL.

A Domain Values
" Reload [l Save W Save All | B8 Constraints Setup

Q- Search (Ctrl+F) 0ef0B O D\"O'Uﬁ
= Name: BloambergCustomHead
+} [ BloombergAIM.UseFpML » ]t S B2
-1 BloombergCustomHeader value: SKIP_PCS

& CREDITRISK

4 IFRS9SPPI Comment: BVAL

e
- BloombergFIT CalypsaMapping. Types <<Add
+ 1 BloombergTOMS, UseFpML

In some cases Variable Spread dates from Bloomberg will be unadjusted when the Payment Rule is adjusted. This
incorrectly creates Spread Period dates that don’t coincide with Coupon Period dates. Variable Spread dates will
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automatically adjust to align with the Coupon Period dates to correct error condition cases (e.g. daily

compounding).

4 Eloomberg Mapping Window — O =
-~ JUE™[300 -US5TREET - EOM A ‘ .
4% 30E*/360 - USSTREET - NON EOM p [ Bloomberg Mapping
- 4% 30E/360 - ISMA - NON EOM Name Value Select
4% ACT(360 - MXN_182 - EOM DAY ONT 103 ; ]
4% ACT/360 - USSTREET - EOM MTG DEAL TYP
-~ 4® ACT/360 - USSTREET - EOM ESUER
4% ACT/360 - USSTREET - EOM RESET 10X
4% ACT/360 - USSTREET - EOM SECURTTY TYP | ]
4% ACT/360 - USSTREET - EOM MTG POOL TYP
- 4® ACT/360 - USSTREET - EOM AMT 1S5UED
4% ACT/360 - USSTREET - EOM PAY RULE
4% ACT/360 - USSTREET - EOM =
4% ACT/360 - USSTREET - EOM
4% ACT/360 - USSTREET - NON EOM
4% ACT/365 - USSTREET - EOM
4% ACT/365 - USSTREET - EOM
YY1 /365 - USSTREET - EOM Calypso Values
4% ACT/365 - USSTREET - EOM — ba
ycount Date Rule
-~ 4% ACT/365 - USSTREET - NON EOM EaymentEie
4% ACT/365 - USSTREET - NON EOM |ADIUSTED v | |FDLLOWING v | |aCT,-‘355 v | | | lz‘
- 4% ACTB/ACTB - BankOfCanada - EOM i X
Yield Method Rolling Day L Acc Daycount
4% ACTB/ACTE - BankOfCanada - EOM Sl LoL PR b
4% ACTB/ACTB - USSTREET - EOM |L"55TREEr i | |E°"‘1 57 | |ﬁCT-"355 3% |
4% ACTB/ACTB - USSTREET - EOM
4% ACTB/ACTE - USSTREET - EOM
e | i
4% ACTB/ACTB - USSTREET - EOM v | B H | ove
o
P See Custom Headers for more details.
8.4.3 Pool Factors Mtge
B soombery upente wodow T =T

=1

MTG T

o1

[ Bloomberg Updates ; . Update Defintion
|5 @ weekday Name Template Based Update
oy racrcon freev sacicm [oorasseeactod
% VADY_FACTGSBA Frequency ExecTme (HHMM)  Run Date (YVYYMDD)
2 WKDY_INDEX
1* WKDY_PRICES [weekday ¥ |
~ Columns
Name Type
MARKET_SECTOR_DES v No Update - Create Task
I0_B8_UNIQUE ~ No Update - Create Task
10_CusiP  No Update - Create Task
1ID_ISIN v No Update - Create Task
WIG ACCRT ~ Update - Greate Task._
HIG_ACC R1_START DT ~ Updse - rest Tosk

~ Update - Create Task

MTG_FACT_SET_DT_STRT_NEXT_ACC_OT |~ Update - Create Task

8.4.4

GSBAs are Market_Sector_Des=

Govt.

Pool Factors GSBA

To capture the pool factors based on Mtge field, you must modify the file by specifying Market sector “Mtge” after

each CUSIP
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ioix
\E Bloomberg Updates : Update Definttion i
o - 42 WKDY_CURCPN 4
0 Wi EACi o [ovFacesen [pondassetpaciedssta | _I
SRWKDY FACTGSBA ] g R
1 WIDY_INDEX Frequency. Exec Time (HHMM) (YYYYMMOD)
& WKDY_PRICES weekday ] |
~ Columns
Name | Type
MARKET_SECTOR_DES |~ Update - No Task
10_65_UNIQUE ~ Update - No Task
10_CusiP ~ Update - No Task
10_I5IN ~ Update - No Task
MTG_ACC_RT + Update - Create Task
MTG_ACC_RT_START DT v Update - Create Task
MTG, FACTO’_!_S_EI or v Update - Create Task
MTG_FACT_SET_DT_STRT_NEXT_ACC_OT ~ Update - Create Task
ioix
oy i ,
= i weekday Name Index Based Update
& WIDY_CURCPN [ meex
¥ WKDY_FACTCPN =
2 WKDY_FACTGSBA sTie o
B oy woex i il by
- 4% WKDY_PRICES weekday ) |
~ Columns
Name Type
LAST_UPDATE_DT + Update - No Task
PX_LAST ~ Update - No Task
ioix
(5 mo«nm'iuwﬁ tes 4 Uodate peimicn i
CR) ‘;fm Nare Template Based Update
12 WKDY_FACTCPN Jwey_prices [s_poncs =l _I
4 WKDY_FACTGSBA S ExecTe (M) Run Date (YYYYMMOD)
4% WKDY_INDEX s )
B KDY PRICES | weekday =N |
~ Columns
Name Type
10_CusIP ~ Update - No Task
MARKET_SECTOR_DES ~ Update - No Task
10_ISIN ~ Update - No Task
10_68_UNIQUE ~ Update - No Task
QUOTE_ASK + Update - Create Task
QUOTE 8D = Update - Create Task
Q‘.DTE_WD v Update - Create Task
QUOTE_TVP ~ Update - No Task
LAST_UPDATE_ DT ~ Update - Create Task

8.4.5 Bond MBS External Cash Flows

Bloomberg Update includes Prepayment Type and Prepayment Speed for External Cash Flow updates.
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AA Bloomberg Update

|1 Bloomberg Updates
=@
4% ARM Update 1
4% ARM_Update_2
4% ARM_Update_3
.. 4% CMO_313680281
4% CMO_383808FL4
. A% MBS_31371LGFO
.. 4% MB5_Update_1
4% svEMultiple
- 4% SVBMutiple2
- 4% SVBMultiple_3
4% svemultiple_4
- 4% SVBSingle3
4% SVBSingle4
4% SVESingles

~

~

a

- ]
Update Definition
Program: | getdata - Template Type: Bond =
Name: |MBS_FLOWS Template Name | Us MBS -
Frequency: |oneshot v RunDate: 20210420 | (YYYYMMDD)
Add Custom Header ExecTme: 1200 | (V)
Bhow Bond Prepay Detail Prepay Type: BAM ~
Prepay Speed: | 100
Edit Prepayment
Columns
MName Type
MARKET SECTOR_DES ~ Update - No Task
1D_BB_UNIQUE ~ Update - No Task
ID_CUSTP ~ Update - No Task
1D_I5IN ~ Update -No Task

MTG_FACT_SET_DT_STRT_NEXT_ACC_DT

~ Update -No Task

MTG_FACTOR_SET_DT

~ Update -No Task

MTG_ACC_RT

~ Update - No Task

HIST_CASH_FLOW

~ Update -No Task

MTG_CASH_FLOW

~ Update -No Task

MTG_PREPAY_SPEED

+ Update - No Task

MTG_PREPAY_TYP

~ Update -No Task

MTG_WACPN ~ Update - No Task
MTG_WAM ~ Update - No Task
MTG_LOAN_AGE ~ Update - No Task

MTG_LOAN_MRGN

~ Update -No Task

MTG_FLT_NXT_RST

~ Update -No Task

MTG_WAM_NXT_RST

~ Update -No Task

MTG_FACTOR

~ Update -No Task

MTG_HIST_FACT

~ Update -No Task

DES_CASH_FLOW

~ Update -No Task

»  Enter a Prepay Speed.

> Select Prepay Type from the drop-down menu.

Note that BAM only supports 100 from Bloomberg.

~

section.

> Check Show Bond Prepay Detail to activate Prepay Type, Prepay Speed and Edit Prepayment fields.

> Enter MTG_CASH_FLOW, HIST_CASH_FLOW, MTG_PREPAY_TYP and MTG_PREPAY_SPEED in the column

The Edit Prepayment button can be selected to override the default Prepayment Type and Prepayment Speed on an

individual trade.

|£:| Edit Prepayment

- O X

Product_ID  Product_Mame

Override  Prepay_Type  Prepay_Speed

115800 FG C91903 : BAM 100
115300 G2 MA1064 : BAM 100
103802 FHR. 4544 EH : BAM 100
123301 GMR. 2015-161 AF : BAM 100
123803 FHMS K073 A2 [0 [pam 100
Apply

»  Check “Show Bond Prepay Detail” to activate the Prepay Type, Prepay Speed, and Edit Prepayment fields.

»  Select Prepay Type from the drop-down menu.
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»  Enter a Prepay Speed.

»  Hit Apply.

| £/ Edit Prepayment = O X
Product_ID  Product_Name Override  Prepay_Type  Prepay_Speed
115800 FG C91903 Z - CPY 0
115300 G2 MA1064 ] BAM 100
103802 FHR. 4644 EH Z - PSA 200
123301 GMNR 2015-161 AF ] BAM 100

H

FHMS K079 A2

Apply

»  Save your changes on the Bloomberg Update Definition screen.

8.5 Scheduled Tasks for Bonds

8.5.1 BLOOMBERG_UPDATE Scheduled Task

The BLOOMBERG_UPDATE schedule task, having the following attribute configuration, sends a request file for all
Updates defined in the Bloomberg Update Window.

This request is generally sent at the end of the business day. DiffFlag can have one of three values:

e No
e Changes
e Empty

If DiffFlag=no, the user must specify the Update Names (e.g., update request filename) that the DiffFlag should
apply to. The Name field (of the Update Definition) in Bloomberg Connect's Bloomberg Update Window holds the
filename. If multiple update names are specified, separate each name by a comma.

When Update Request files are created, only the Update Names specified by the user have a “DiffFlag=no” record.
All other update request files have a “DiffFlag=changes” record.

If the value of DiffFlag is anything other than “no”, the update request files will have a “DiffFlag=changes” record.
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Report Tools  Help

Definition | Report |

@ Tee IBLOOMEERG,UPDATE Descriptian |1‘ Send the update requsst to BB Frocess Orul

=
Trade Filter | >|  prigngEny | = Risk Cunﬁg|
user | | Fiter Set | =l Next 1d[o
Measures | _I Check
Time Zone | America/MNew_York v Exec Tine: H M Yal Date Offset |0
From Days [0 0 o VaationTwd 12 H oM Date Rule
Holidays _| Undo Tims H "

[~ skip Exec  CutOff [0 Haur |0 Miry

KINE

[ Private [~ DeActivated

- [VExecute [~ Read Only Server
Altribute Value ["Publish [ ~Send Email [~ Exec On Holidays
Action ~ 1 - Send Request For Updates |
DIFFFLAG = o Comment
Update Names |WKDY_FACTCPN, WKDY_FACTGSEA, WiDY_PRICES, WKDY_CLF DiffFlag should be set to no
Input Dir
Input Files =
4| | »
d Type Description Pricing Enw. Trade Filter Filker Set User Ti
1702|BLOOMBERG_UPDATE 2. Process updates rcvd Ffrom BB BACKOFFICE AmEn((:I
2701

Armnerice

2301

Americy
Amel’i&J‘

L i BACKOFFICE

2501 [BLOOMBERG_UPDATE 1. Send the update request to BB Americ:
2502[BLOOVMBERG_UPDATE [BACKOFFICE Americ:
2201 [CHECK_BOND_VALIDITY Bonds that are incorrectly set up Americ:
1003/CLOSING dlose pl accounts at year end BACKOFFICE Americ: v |
4 »

New | Delete | Save | Save As New Refresh d (1701 Close

The BLOOMBERG_UPDATE scheduled task, with the following attribute configuration, automatically retrieves all the
*.out files for all defined Updates.

The application attempts to match the names defined in the Update Definition window with the files on the
Bloomberg FTP. Matching files are then downloaded.

Once the Bloomberg Update task is complete, any downloaded updates are applied to the Bond. The application
will only update those fields that the user requested using the Bloomberg Update window.

The Task Station then displays two types of tasks. One informs the user which Product ID was updated, and the
second provides the data that was altered or added.
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Report Tools  Help

Definition | Report |

()] Type |BL00MEERG7UPDATE

Description |2 Process updates rovd From B8

[ | e [

Trade Fier | = PricnoEnv [packorrice =] RiskCnrﬂgI [~

User | =] Fikerse| =] Next 14fo L
Heasures | 2] Check

Tirne Zone Im'nericaﬁ'-lew_‘fork

=] Bectine| 1 H [ o

From Days |0 To

wieas [ .

fo Valuation qu 1 H o0 M
Unda Time I H M

[ SkipExec  CukQff |0 HaLrF Min

M

‘fal Date: OFFﬂetIE
Date Rulel

I~ Private [ DeAckivated

e [V Execute [~ Read Only Server
Attribute ‘alug ™ Publish [~ Send Email [ Exec On Holidays

Ackion = 2 - Process Updates Received

DIFFFLAG - St

Update Names

Input Dir

Input Files

Update Known Date
Id Type Description Pricing Ere Trade Filter Filker Set LUser [ Ti
1702|BLOOMBERG_UPDATE 2. Process updates rovd from BE BACKOFFICE Amerlci:]
2701 |BLOOMBERG_UPDATE 1, Send the ADHOC Americt
1701 |BLOOMBERG_UPDATE 1. Send the update request to BE AmErics

up fie

1. Send the update request to BB

A
Americt

2801 |[BLOOMBERG_UPDATE

2802 | BLOOMBERG_UPDATE BACKOFFICE Amnerics

2201 |CHECK_BOND_VALIDITY Bonds that are incorrectly set up Americs

1003|CLOSING close pl accounts &t year end EACKOFFICE Americi = |

l [ 0|
New ] Delete | Save | Save fs New | Refresh | i Eam Close

8.5.2

Reprocessing Files in BLOOMBERG_UPDATE

It is possible to reprocess an update file once it has been imported from the FTP site. Enter the file name(s) in Input
Files and their containing directory in Input Dir.

Report Tools  Help
Befinttion | Report |

@)  Type [BLOOMBERG_UFDATE 'I
Trade Filber hud I
User - I

Description |2. Process updates rovd from B8
Pricing Env | BACKOFFICE -
Fiker Set -

Measures I

Time Zene |Americalew_Yark -

[~ SkipExec  Cutoff |0

Hour (0 Min

Exec Tlnul 15 H | 47
Valuation Tir4 15 H I 47 M
Undo l\mel H I L

]

[ Execute

Coenment

Process Q'gl |
F[H:Cuﬁul
Next ldll]

\l'elDebeOstdF
Date Rule

[ Private [ DeActivated

["Publish [ Send Email

| 4

Chek

™ Read Ornly Server

[ Exec On Holidays

Attributes
Attribute Value

Action ~ 2 - Process Updates Received
DIFFFLAG -
Update Names
Input Dir i Temp
Input Files WKDY_FACTCPN
Update Known Date

BERG_LPDATE

1. Send the ADI

&5 rowd from BB

Tradz Fiker

2701 BLOOMBERG_UPDATE HOC Americe
1701 BLOCHMBERG_LUPDATE 1. Send the update request to BB Americ:
2301 BLOCMBERG_UPDATE 2. Process updates rcvd from BB BACKOFFICE ﬂmalch
2801 BLOOMBERG_LPDATE 1. Send the update request to BE Americe
2802 BLOOMBERG_UPDATE [BACKOFFICE Americe
2201 CHECK_BOND_VALIDITY Bonds that are incorrectly setup Aimeric:
1003/ CLOSING close pl accounts at vear end IBACKOFFICE Americi = |
4| | 3
mow | pelets | save | ssvessmew | Refresn

Id [1702 Close
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8.5.1 BLOOMBERG_UPDATE ST with a new attribute called “Skip Existing Quotes”

Added a new attribute called as “Skip Existing Quotes” to the “BLOOMBERG_UPDATE” Schedule Task. This will
ensure that the Entered Date for the fallback quotes are not being constantly updated due to the fact that we will
be importing the same quotes day after day based on the date range.

User should use the BLOOMBERG_UPDATE ST where the user uses a Task Attributes Action field “2-Process
Updates Received”. Here we have a new field known as Skip Existing Quotes as true/false.

If the Skip Existing Quotes is “True” then the ST should skip saving of quotes which had been already persisted in
the database. The default value for Skip Existing Quotes will be False. If the attribute is true then the ST will not
update any existing quote data set that is already saved, even if the quote feed is resending this data. If the Skip
Existing Quotes is flipped to “False” then the ST will update the existing quotes and overwrite it.

Task Description

Task Type:
External Reference:
Comments:

Description:

BLOOMBERG_UPDATE
Bloomberg_Update_1|
Bloomberg_Update_1
Bloomberg_Update_1

Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA): |5 minutes

IVM Settings: |-Xms512m -Xmx1024m

Log Settings:

Task Motification Options
|:| Send Emails |:| Publish Business Events ~ To User: R

[=] Common Attributes

Task ID 120621

Processing Org

Trade Filter

Filter Set

Pricing Environment OFFICIAL

Timezone Americaflos_Angeles

Valuation Time Hour
Valuation Time Minute

Undo Time Hour 0
Unda Time Minute ]
Valuation Date Offsat

From Days a
To Days o]

Pricer Measures
Business Holidays
[=] Task Attributes

Action 2 - Process Updates Received
DIFFFLAG no

Update Names IBOR_350

Input Dir

Input Files IBOR_350

Update Known Date yes

Skip Existing Quotes Falze

8.5.2 Cash Flow Ad-hoc Updates

You must periodically update the BondAssetBacked cashflows through a bulk request. The normal update process
from Bloomberg does not update ad-hoc cashflows.
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Defining the Update
In Bloomberg Connect > Utilities > Bloomberg Cash Flow Update Status, define the following update:

A Bloomberg Cash Flow Update — O X

2] Bloomberg Cashflow Updates |4  Update Definition
B'j weekday Program: | getdata v Template Type: Bond v
4% AD_CASHFLOW
Name: |AD_CASHFLOW Template Name | US ABS ~
Frequency: weekday ~ Run Date: (YYYYMMDD)
Add Custom Header Exec Time: (EEERD
Feed: ~
Columns
Name Type
ID_BB_UNIQUE - Update - No Task
ID_CUSIF ~ Update - No Task
ID_ISIN - Update - Mo Task
MARKET_SECTOR_DES ~ Update - No Task
MTG_CASH_FLOW - Update - Mo Task

BLOOMBERG_CASHFLOW_UPDATE Scheduled Task
Add BLOOMBERG_CASHFLOW_UPDATE to the “scheduledTask” domain.

Step 1 - Send Request for Updates

Task Description
Task Type: |BLOOMBERG_CASHFLOW_UFDATE

External Reference:
Comments:

Description:

Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA):

VM Settings: |-Xms312m -Xmx1024m
Log Settings:

Task Notification Options
[ ]send Emails [ ] Publish Business Events  To User: w

Common Attributes

= Task Attributes
Action 1 - Send Request for Updates

Input Dir
Input Files
The Scheduled Task application creates the file “zzh_AD_CASHFLOW.req,” which looks similar to the following

“one-shot” request:
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START-OF-FILE

# Calypso Request File (Generated: 6/21/06 2:22:43.222 PM CEST)

# Request Header REPORT=yes PROGRAMFLAG=oneshot FIRMNAME=dl*****%*
REPLYFILENAME=zzh ADHOC.out.enc HISTORICAL=yes

DERIVED=yes SECMASTER=yes

PROGRAMNAME=getdata DATEFORMAT=mmddyyyy

# Request Fields START-OF-FIELDS ID CUSIP
ID ISIN MARKET SECTOR DES MTG CASH FLOW ID BB UNIQUE

END-OF-FIELDS

# Request Data START-OF-DATA
BCCOCF6Y3|CUSIP|1]| SETTLE_DT | 19720101 | END-OF-DATA

END-OF-FILE

Step 2 - Process Updates Received
Task Description
Task Type: |BLOOMBERG_CASHFLOW_UPDATE
External Reference:
Comments:
Description:
Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA):
VM Settings: |-Xms512m -Xmx1024m

Log Settings:
Task Motification Options

[ ]send Emails [ ] Publish Business Events ~ To User: o

Common Attributes

ElTask Attributes
Action 2 - Process Updates Received

Input Dir
Input Files

The cyh_AD_CASHFLOW.out received automatically updates the products.

8.5.3 BLOOMBERG_CHECK_EXT_FLOWS Scheduled Task

For FAS91, Calypso must import the external cashflows from Bloomberg.

The scheduled task publishes exceptions for all BondAssetBacked bonds to mention the last update time for any
bonds that actually have an external cashflow. The goal is to identify missing cashflows and to determine which
cashflows are not being updated.
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On the Task Station, it generates:

e A BLOOMBERG_INFORMATION item for each ABS bond that has external flows (and when the flows were last
downloaded).

e A BLOOMBERG_EXCEPTION item for each ABS bond that does not have an external flow.

Add BLOOMBERG_CHECK_EXT_FLOWS to the domain “scheduledTask”.
Task Description
Task Type: |BLOOMBERG_CHECK_EXT_FLOWS
External Reference:
Comments:
Description:
Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA):
JWUM Settings: |-Xms512m -Xmx1024m

Log Settings:

Task Notification Options
[ ]send Emails [ _] Publish Business Events  To User: e

[ common Attributes

8.5.4 CHECK_BOND_VALIDITY Scheduled Task
This schedule task has a single attribute, a static data filter.

When the scheduled task runs, Calypso queries for bonds that match the static data filter and runs the “validate”
logic on them (this is the same validation logic that runs when saving the bond).

If any bond fails the validation, Calypso raises a task to the Task Station that records both the bond and the error
message.
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Task Description
Task Type: |CHECK_BOND_VALID l'I'Y1

External Reference:
Comments:
Description:
Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA):
JVM Settings: |-Xms512m -Xmx1024m

Log Settings:

Task Motification Options
[ ]send Emails [ ] Publish Business Events  To User: b

| common Attributes
= Task Attributes
STATIC DATA FILTER

To configure the Task Station for CHECK_BOND_VALIDITY:
Add INVALID_BOND_ERROR to the domain “exceptionType”.

Add an “Invalid Bonds” report to the Task Station:

A Report Configurations X
J Task Station Tabs |Task Enrichment Filters]
Q Name Value
Tab Name nvalid Bonds
Workflow Types Exception
Books _ANY_
Book Attributes
Event Types EX_INVALID_BOND_ERROR  [..]
Priarities LOW, NORMAL, HIGH, CRITICAL...
Task Statuses MEW, UNDER_PROCESSING, CO...
Enrichment Columns Filter
Task Date Type TaskDatetime
From Tenar -1M
To Tenor +1M
Catalog Aute Count L1

8.5.5 BLOOMBERG_BULKUPDATE Scheduled Task

This scheduled task is used to upload multiple Bloomberg out files that are present in the specified directory. We
can also provide a filter using wildcard character (*) to upload specific out files that matches the filer in the
directory.
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Task Description
Task Type: BLOOMBERG_BULKUPDATE

External Reference:
Comments:
Description:
Execution Parameters
Attempts: |1 Retry After: 0
JVM Settings: | -Xms312m -Xmx1024m

Log Settings:

Task Motification Options
[ ]send Emails  [_] Publish Business Events

Hl Common Attributes

=ITask Attributes
Input Directory C:\Bloomberg\BBG_Update
File Name Pattern cy*.out

Task Attributes:

Expected Execution Time (SLA):

e Input Directory (Mandatory): We need to specify the full path of the directory that contains the out files. This
field cannot be empty. A warning message will be displayed and will now allow creating the scheduled task if

the field is empty.

e File Name Pattern (Optional): We can provide a filter to upload only specific set of out files from the directory.
We can achieve this by specifying the file search pattern using wild card character (*). Since this field is
optional, if we did not specify any value in this field then all out files in the specified directory will be uploaded.

Sample search patterns: 'cyc_HYG_UP.out' this file will be picked by following any of patterns.

- *out

—  *UP.out

— ccy_HYG*.out

— ccy*UP.out

— ccy*HYG*UP.out

You may add BLOOMBERG_BULKUPDATE to the domain “scheduledTask” if it is not available for selection, and to
the domain “exceptionType” to monitor exceptions on that scheduled task.

You also need to add EX_BLOOMBERG_BULKUPDATE to the domain “eventType”.
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A Report Configurations x

i | Task Enrichment Filters

Name Value
Tab Name Bloomberg Info
Waorkflow Types Exception
Books _ANY_
Book Aftributes
Event Types EX_BLOOMBERG_BULKUPDATE [...]
Priorities LOW, NORMAL, HIGH, CRITICAL...
Task Statuses MNEW, UNDER_PROCESSING, CO...
Enrichment Columns Filter
Task Date Type TaskDatetime
From Tenor -1M
To Tenor +1M
Catalog Auto Count L]

8.6 MBS External Cash Flows

Calypso can create or update the Bond Cash Flows to use Bloomberg Cash Flows. Bloomberg Cash Flows include
several Prepayment Types including PSA, CPR, BAM, CPY and CPJ.

P See ABS Panel for details on the prepayment types.

[NOTE: Bloomberg may require an upgrade license to Calculation Services to use some of the
Prepayment models including BAM.]

8.6.1 Configuration

To enable the External Cash Flows functionality the domain
“BondAssetBacked.USE_EXTERNAL_FLOWS_FOR_PRICING” must be set to true.

A Domain Values - O X
éh Reload [l save Uj; Save All | [#%] constraints Setup (7]
Search (Cirl+F) 20f17@ @ | [ Value
T Name: BondAssetBacked USE_EXTERMAL_FLOWS_FOR_PRICING
=[] BondAssetBacked, USE_EXTERNAL_FLOWS_FOR_PRICING A
L4 m Value: |true

-] BondBrady Pricer
-] BondBrady.subtype
-[] BondCertificate. Pricer

Comment:

-[77] BondCertificate, subtype << Add Add & Save
[ 7] BondCLN,Pricer
7] BondCLN. subtype >> Remove

-] BondConvertible, Pricer
-] BondConvertible. subtype
-[ 7] BondDanishMortgage Pricer
-] BondDanishMortgage. subtype
-[[7] BondExotichote.Pricer
7] BondExoticMote.subtype
-] BondFRM. Pricer
-] BondFRN.subtype

To add Prepayment Types to the available options in Bloomberg Connect they need to be added to the domain
“Bloomberg.PrepaymentType”.
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A Domain Values - O *
& Reload || Save Save Al | [ Constraints Setup {

BAM 20f5@ @ Valug

=)/ Bloomberg. PrepaymentType -
T

4% cpJ

R o

L4 CPY

i 4% psp << Add Add & Save
----- [ BloombergCustomHeader
----- [ Bo_position_snapshot
----- .j Bo_position_snapshot_sequence
[]---.j BOMessagelncompleteStates
-] Bond.Pricer

[ [ DU I U PP R Ty

Mame: |Bloomberg.PrepaymentType

Value: BAM

Comment:

== Remove

In addition, the same types must be added to domain “ABS.PrepayTypes” to display properly in Calypso.

Important Note: When setting the Domain “BondAssetBacked.USE_EXTERNAL_FLOWS_FOR_PRICING” to
TRUE it is highly recommended to request MBS Factors (MTG_HIST_FACTOR or MTG_FACTOR_SET_DT)
and Cash Flows (MTG_CASHFLOW and HIST_CASH_FLOW) in the same request.

8.6.2 Requesting MBS Bonds using External Cash Flows
To request the default Prepayment Type and Speed (see Requesting an Individual Product):
»  Select the Security Code.
»  Enter a Value that identifies the security. Click Add.
»  Click Submit Request.
To request a Prepayment Type and Speed other than the default (e.g. BAM 100):

»  Select the Sector — Mortgage — MTGE. This activates the Override Prepay Type and Override Prepay Speed
fields.

»  Select the Security Code.
» Enter a Value that identifies the security.
» Enter an Override Prepay Type from the drop-down menu.
»  Enter an Override Prepay Speed. Click Add.
Note: BAM only supports 100 from Bloomberg.

»  Click Submit Request.

A BloombergConnect

Utilities

Request  Import From File
Selections

Sector: | Mortgage —Mige v | Security Code: | CUSIP | Value:
Overrride Prepay Type:|BAM . Override Prepay Speed: | 100
Sector Security Code Value PrepaymentType PrepaymentValue

CUsP__________ [3128PEDLD
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[NOTE: When requesting MBS bonds that have adjusted period schedules and RFR-based indexes, the
current period will adjust as per the adjustment rule.]

8.6.3 Requesting Multiple Bonds using External Cash Flows

Multiple Bonds can be requested manually adding multiple bonds and selecting Prepay Type and Prepay Speed per
each security. In addition, multiple Bonds can be selected by using the Add From File functionality.

#

# Start of Data
Market Sector=Mtge
Product Code=CUSIP

#Column heading

#Identifier SecurityCode  MarketSector PrepayType  PrepaySpeed
3137BUPH5 BAM 160
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9 Known Dividends

Bloomberg provides Last Known Dividend data for Equities and Daily Dividend information for Equity Indexes.

9.1 Calypso Last Known Dividend Processing

Calypso will create new dividends when necessary and create a Cash Dividend Corporate Action record, as well.

Calypso processes the following fields:

Bloomberg Field Description

DVD_CRNCY Dividend currency
EQY_DVD_SH_LAST Dividend amount
EQY_DVD_FREQ Dividend Frequency
DVD_DECLARED_DT Dividend Declared Date
DVD_RECORD_DT Dividend Record Date
DVD_PAY_DT Dividend Payment Date
DVD_EX_DT Dividend Ex Date

9.2 Obtaining and Processing Daily Dividends

For an Equity Index, include the EX_DVD and DVD_EX_DT fields to request Daily Dividends. The information
returned is:

° Ex Date
e Dividend Date

Additionally, when the user requests Daily Dividends through the Bloomberg Update, Calypso includes the Index
Divisor and the Index Member Weights in the request. This information is used to update basket information, if any.
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10 Cheapest To Deliver Data

It is possible to import cheapest to deliver data for future contracts from Bloomberg Data License.

In order for this functionality to work, future contracts need to be setup in Calypso with BB_TICKER_EXCHANGE
product code set to the Bloomberg future contract’'s name. Also, the deliverable bonds need to exist in Calypso. If
they do not exist, they need to be imported from Bloomberg before using this functionality. Bonds need to have the
ISIN or CUSIP product code set so they can be looked up as CTD.

The following Bloomberg fields are supported for CTD data.
Mandatory Bloomberg Fields

e TICKER

e MARKET_SECTOR_DES

e FUT_HAS_CTD

e FUT_CTD

e FUT_CTD_CUSIP

e FUT_CTDLISIN

e FUT_CTD_TICKER

e FUT_CNVS_FACTOR
Optional Bloomberg Fields

e FUT_DLVRBLE_BNDS_BB_UNIQUE
e FUT_DLVRBLE_BNDS_CUSIPS
e FUT_DLVRBLE_BNDS_ISINS

e FUT_CTD_PX

If optional fields are not requested, only the CTD will be set on existing future contracts if the list of deliverable
bonds contains CTD bonds, otherwise an error task will be created.

If FUT_DLVRBLE_BNDS_ISINS, FUT_DLVRBLE_BNDS_CUSIPS and/or FUT_DLVRBLE_BNDS_BB_UNIQUE are
requested, a new list of deliverable bonds will be created if all bonds exist in Calypso otherwise an error task will be
created. After creating a new list, the CTD will be set from this list.

If FUT_CTD_PX is requested, a new quote will be created in Calypso for CTD bonds with last value.
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11 Corporate Actions

Bloomberg supports a subset of Corporate Actions. Some of these Corporate Actions (CAs) affect a specific
security and some only the issuer. Many CAs imported by Calypso have no economic, security, or position impact.

For more complete corporate actions support, it is recommended to import SWIFT messages MT564-MT568
instead. Please refer to Calypso Corporate Actions documentation for details.

11.1 Overview

Action Mnemonics are used to request supported individual action types. All corporate action messages contain an
Action ID, which is a Bloomberg-assigned, unigue identifier.

All Corporate Action messages have an internal status flag that marks them as New, Updated, or Deactivated, N, U,
and D, respectively.

Calypso's internal processing uses the Action ID and the status flag to determine the action to take with the
message.

All other CA types reported by Bloomberg are imported into Calypso as “Referential/Informational.” Such CAs
require no further processing action within Calypso.

Calypso fully supports the following Corporate Actions from Bloomberg:

e Stock Split

e Cash Dividend
e Stock Dividend
e Spinoff

e Merger

Bloomberg Corporate Actions — Bold == Supported

BBG CA Name Type (CE, | Issuer (C) Action Mnemonic | Calypso Model

CC, or D) | or Security

)
Name Change CE C CHG_NAME Referential Informational
Listing CE S LIST Referential Informational
Domicile Change CE C CHG_DOM Referential Informational
Variable Interest CE S VAR_INT_RST Referential Informational
Reset
State of CE C CHG_STATE Referential Informational
Incorporation
Change
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BBG CA Name Issuer (C) Action Mnemonic | Calypso Model Calypso

or Security

Subtype

Voting Rights
Change

Round Lot Change

Currency Quotation
Change

Ticker Symbol
Change

Reconvention

ID Number Change
Redenomination
Delisting

Shareholder
Meeting

Change in Listing
Merger

Installment Call -
Partial Pay

Spin-off
Reclassification
Bankruptcy Filing

Debt
Repurchase/Tender

Stock Buyback

Debt
Redemption/Put

Equity Offering

Exchange Offers

CE

CE

CE

CE

CE

CE

CE

CE

CE

CE

cC

cC

CcC

cC

CcC

cC

cC

cC

cC

cC

(S)

CHG_VOTE

CHG_RLOT

CRNCY_QT_CHN
G

CHG_TKR

RECONVENTION
CHG_ID
REDOMINATION
DELIST

SH_HOLDER_MEE
T

CHG_LIST
MERG

PARTIAL_PAY

SPIN
RECLASS
BANCR

DBT_REP

STOCK_BUY

DBT_RDMP_PUT

EQY_OFFER

EXCH_OFFER

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

MERGER

Referential

SPINOFF

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

MERGER

Informational

SPINOFF

Informational

Informational

Informational

Informational

Informational

Informational

Informational

August 2024

Revision 68.0 / Approved
Private and Confidential

Page 97 /128



IOI Nasdaq

Nasdaqg Calypso
Bloomberg DL Products Integration Guide / Version 12.17.0

BBG CA Name

Issuer (C)

or Security

Action Mnemonic

Calypso Model

Calypso
Subtype

Debt Redemption
Call

Variable Principle
Redemption

Debt
Offering/Increase

Pay in Kind

Debt Offering/New
Rights Offering

Par Value Change

Conversion Price
Refix

Debt Redemption
Sinker

Exercise Terms
Refix

Acquisition
Funged Issues
Divestiture
Extendible Issues
Cash Dividend S
Stock Dividend S

Stock Split S

CC

cC

cC

cC

CcC

cC

CcC

cC

CcC

cC

CcC

cC

cC

cC

(S)

DBT_RDMP_CALL

VAR_PR_RDMP

DBT_OFFER_INC

PAY_IN_KIND
DBT_OFFER_NEW
RIGHTS_OFFER
CHG_PAR

CONV_PX_RFIX

DBT_RDMP_SINK

EX_PX_RFIX

ACQUIS
FUNGL_ISS
DIVEST
EXTEN_ISS
DVD_CASH
DVD_STOCK

STOCK_SPLT

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

Referential

CASH

ACCRUAL

TRANSFORMATION

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

Informational

DIVIDEND

STOCK_DIV

SPLIT
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11.2 Obtaining Corporate Actions

To obtain corporate actions, first open the Bloomberg Update window from Bloomberg Connect.

A Bloomberg Update — O h4
1 Bloomberg Updates 4 Update Definition
B+ oneshot Program: getactions o Template Type: | Equity
Name: Template Name v
Frequency: | daily e Run Date: (YYYYMMDD)
Actions: | All ~ Exec Time: (HHMM)
Action Date: | effective e Date Range: (YYYYMMDD)

Add Custom Header

Feed: w4

Corporate Actions are retrieved using the getactions program.
When the getactions program is selected, the following become available:

e Actions — Choose the type of CA you wish to retrieve, or leave the default setting of All to retrieve all
corporate actions.

e Date Range — An inclusive range of days to retrieve CAs. The limit set by Bloomberg is seven days before
the Run date (typically, today). When Frequency is oneshot, Date Range is mandatory. getactions will return
a single day if Date Range is left blank (except for oneshot requests).

e Action Date — The date on which the CA occurs.

11.3 Corporate Action Workflow

11.3.1 Scheduled Tasks

Bloomberg enters and updates Corporate Actions daily. To ensure that your data is current, Calypso recommends
that you create a Scheduled Task to request CAs each day.

Your CA Scheduled Task should:

e Gather the Equities whose CAs should be requested.
e Request all CAs that have been entered updated or deleted for a given day.

Monitor the Task Station for exceptions and process them as required.

11.3.2  Calypso Corporate Actions Processing
Calypso CA processing follows these steps:

e Process any unsupported CA types as Referential/Informational CA Records. The application stores a maximum
of 255 characters from the beginning of the raw CA message in the Comments field, which will include the
Bloomberg CA Type and the remaining fields delimited by the bar character (| ). Calypso also accepts and
processes updates to Referential/Informational CA messages.
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e Process CA messages for supported types using the following logic:

Bloomberg Action ID Exists? | Current Record | Process Date is Processing Result
Status Flag Status is:

D No N/A N/A Ignore CA Message
D Yes Active LT Existing Ex Date Deactivate CA record
D Yes N/A GE Existing Ex Date Ignore CA Message
N or U Yes or No N/A LT Existing Ex Date Create CA record

N or U Yes or No Active LT Existing Ex Date Create CA record

N or U Yes or No Active GE Existing Ex Date Ignore CA Message

[NOTE: Under no circumstance are existing CA records modified on or after the Ex Date that currently
exists in the CA record or when the CA record is Deactivated.]

1.4 CA Record Types

11.4.1 Common Fields

The following fields in the Corporate Action window are typically populated in all messages:

Product The Security ID of the product this CA is associated with. <ldentifier>
To product Used in the case of a Spinoff or Merger when another
product is involved. This field will contain the Security ID of
the new product.

Model This field, with the SubType field, drives the identification of
the CA. The mapping of these fields is given in the Bloomberg
CA summary table.

SubType See Model.

Ratio From The number of old shares. Used in Stock Splits and Spinoffs.
(Transformational CAs).

Ratio To The number of new Shares. See above.

Rounding Used to determine how to treat fractional amounts due to
odd splits and other CAs.
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Field Description Mapping
Record Date The Record Date.
Payment Date The date on which the company considers holders of the

security as being entitled to the payout.

Ex-Date Critical Field. The day to adjust the positions in this product.
Amount An amount to pay.

Other Amount An additional amount to pay.

Currency The currency of the Amount.

Comment Text field.

11.4.2 Referential/Informational

Calypso only stores the following fields for Referential/Informational CA Message:

Calypso Field Value

Product The Security ID (SeclD).

Model REFERENTIAL

Sub-type INFORMATIONAL

Deactivated True or False.

Comments Formatted text of the message in the following format:

<Type>,<Flag>,<Fields> Fields <return>

<Fields specific to CA>

[NOTE: The CA Message is truncated to 255 characters.]

Record Date Effective Date
Ex Date Effective Date
Pay Date Effective Date + 1

11.4.3  Stock Split

A stock split occurs when a company alters the number of its outstanding shares without changing the total market
value of those shares. After a stock split or reverse stock split (i.e., a consolidation) becomes effective, the price of
the shares is proportionately adjusted.
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The following table summarizes the Calypso CA record fields and Bloomberg fields that are specific to Stock Splits:

Calypso Field

Product
To product
Model
SubType
Ratio From
Ratio To

Rounding

Value

Security ID

Blank
TRANSFORMATION
SPLIT

The split ratio.

How share rounding is applied to this
stock split.

Bloomberg Field/Notes

Not applicable to Stock Split.
N/A
N/A

CP_TERMS is parsed to obtain these fields. E.g.,
a split could have the values Ratio From 2, Ratio
To 3. A consolidation could be the reverse.

CP_SHARE_FRACTIONAL.
Rounding will have one of the following values:

e Unknown

e Cashin Lieu

e Round Up

e Round Down

e Fractional Shares

e Natural Rounding

e Round to nearest half share
e NA.

Record Date

Payment Date

Ex-Date

Amount
Other Amount
Currency

Comments

Record Date Inclusive

The date on which the company
considers holders of the security as
being entitled to the payout.
Effective Date.

Effective Date

Blank
Blank
Blank

Free text

True

CP_RECORD_DT

CP_PAYMENT_DT is not used here.

If the Effective Date is N.A., then ExDate is
blank.

CP_NOTES.

If N.A., then Comments is empty.

Always set to true.
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11.4.4

Cash Dividend

[NOTE: The Effective Date for cash dividends is the Ex-Dividend date, i.e., the first date the security
trades without entitlement to the current dividend.]

A Cash Dividend occurs when a company makes a cash distribution to shareholders. The following table the typical

fields in a Cash Dividend:

Calypso Field

Product
To product
Model
SubType
Ratio From
Ratio To
Rounding

Record Date

Payment Date
Ex-Date

Amount

Other Amount

Currency

Comment

Record Date Inclusive

Value

Security ID

Blank

CASH

DIVIDEND

Blank

Blank

Blank

The date on which the company
considers holders of the security as
being entitled to the payout.
Payment Date

Effective Date

The amount of the Cash Dividend.

Blank

The currency of the dividend amount.

True

Bloomberg Field/Notes

N/A

Not applicable for Cash Dividends.
Not applicable for Cash Dividends.
Not applicable for Cash Dividends.

CP_RECORD_DT

CP_PAY_DT
Blank if Effective Date is N.A.

CP_NET_AMT

See Currency for processing notes.
Not applicable for Cash Dividends.

CP_DVD_CRNCY

Note: When a currency received from
Bloomberg ends in “p” (e.g., GBp), the amount is
divided by 100.

CP_NOTES

If N.A., then Comments is empty.

Always set to true.
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Calypso Dividend Processing

When Calypso creates a CA record, a row in the Realized Income table on the Equity Window’s Dividend tab is also
created. The CA ID column in the Dividend row points back to the Corporate Action ID received from Bloomberg.

Dividend Attribute Value

Declared Date Identical to the Corporate Action.
Record Date Identical to the Corporate Action.
Ex-Date Identical to the Corporate Action.
Amount Identical to the Corporate Action.
Adj. Amount Blank
Type Type of Dividend:

e Regular

e Special

e Final

e Interim
Franking % CP_FRANKED_AMT

Percentage of Franking Credit.
Dividend ID Generated when you the dividend is applied.
CAID The CAID.

11.4.5 Stock Dividend

A Stock Dividend occurs when a company makes a distribution of Stock to shareholders. The following table the
typical fields in a Cash Dividend:

Calypso Field Value Bloomberg Field/Notes
Product Security ID
To product Blank N/A
Model ACCRUAL
SubType STOCK_DIV
Ratio From 100 Always 100.
Ratio To n CP_AMT
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Calypso Field

Rounding

Record Date

Payment Date
Ex-Date

Amount

Other Amount
Currency

Comment

Record Date Inclusive

Value

Blank

The date on which the company
considers holders of the security as
being entitled to the payout.
Payment Date

Effective Date

The amount of the Cash Dividend.

Blank

Blank

True

Bloomberg Field/Notes

The number of shares distributed for each 100
shares held by the shareholder.

Not applicable for Stock Dividends.

CP_RECORD_DT

CP_PAY_DT
Blank if the Effective Date is N.A.

CP_NET_AMT

See Currency for processing notes.
Not applicable for Stock Dividends.
Not applicable for Stock Dividends.

CP_NOTES
If N.A., then Comments is empty.

Always set to true.

11.4.6  Spin-off

A spin-off occurs when a company makes a proportionate free distribution of shares, in a unit or other company, to

its current shareholders.

Calypso Field

Product

To product

Model
SubType

Ratio From

Value

Security ID

Blank or Security ID

SPINOFF

SPINOFF

Bloomberg Field/Notes

CP_TKR

This field is used only if the spunoff Equity
exists in the database with a
TICKER_AND_EXCH_CODE identical to CP_TKR.

If such a product does not exist, then the field is
blank and the record is marked Deactivated.

CP_TERMS is parsed to obtain these fields. E.g.,
a spinoff could have the values Ratio From 2,
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Calypso Field Value Bloomberg Field/Notes
Ratio To 3, meaning for every two shares of the
Product, distribute 3 shares of the To product.
Ratio To n
Rounding How share rounding is applied to this | CP_SHARE_FRACTIONAL.
spinoff. Rounding will have one of the following values:
e Unknown
e Cashin Lieu
e Round Up
e Round Down
e Fractional Shares
e Natural Rounding
e Round to nearest half share
e N.A.
Record Date The date on which the company CP_RECORD_DT
considers holders of the security as
being entitled to the payout.
Payment Date The Effective Date CP_PAY_DT
Ex-Date Effective Date Blank if the Effective Date is N.A.
Amount Blank Not applicable for Stock Dividends.
Other Amount Blank Not applicable for Stock Dividends.
Currency Blank Not applicable for Stock Dividends.
Comment CP_NOTES
If N.A., then Comments is empty.
Record Date Inclusive | True Always set to true.

Calypso Spinoff Processing

A spun-off Equity must exist in the Calypso database for processing to occur on the Ex-Date. The client must add
the Equity manually at any time until midnight on Ex-Date - 1 for automatic processing CA to occur.

Workflow for a Spin-Off

Follow normal CA processing. If the Process Date is GE to the Ex-Date and it is an update, then do not apply.
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Look up the Spun off stock by CP_TKR. If it does not exist, then add the CA in a Deactivated state and withouta To
Product. If the Spun off stock exists, then add the CA in a “Activated” state with a To Product.

Ensure the Comment field holds Spinoff Fields using formatting for “Informational” CA's.
Example

e Jan-01-2010: The Spinoff is announced. The Spun-Off stock is not in Calypso database. Calypso add the Spin-
off CA record to the database in the Deactivated state.

e Jan-02-2019: The Client manually adds the Stock and activates the Spin-Off.

e Jan-04-2010: A Spinoff update is received. The Spinoff is updated and the corporate action remains activated
because the Spun off product exists.

When a Spin-off for an unknown product occurs, Bloomberg Connect generates an exception to the Task station

stating:

"Spinoff: Spun off Stock does not exist in Calypso for ID <BBG ID>, Stock

<Ticker to Stock> , Ex-Date <Eff Date>, Spun off Stock <CP_TKR>. Please add this stock and activate CA.

11.4.7 Merger

A merger is an agreement between two or more companies to merge together and form one entity (company).

Calypso Field Value Bloomberg Field/Notes

Product Security ID

To product Blank

Model MERGER

SubType MERGER

Ratio From n CP_TERMS is parsed to obtain these fields. E.g.,
a merger could have the values Ratio From 2,

Ratio To n Ratio To 3, meaning for every two shares of the
Product, distribute 3 shares of the surviving
company.

Rounding How share rounding is applied to this | CP_SHARE_FRACTIONAL.

Smei: Rounding will have one of the following values:

e Unknown
e Cashin Lieu
e Round Up
e Round Down
e Fractional Shares
e Natural Rounding
e Round to nearest half share
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Calypso Field Value Bloomberg Field/Notes
e NA.
Record Date The date on which the company CP_RECORD_DT

considers holders of the security as
being entitled to the payout.

Payment Date The Effective Date CP_PAY_DT

Ex-Date Effective Date Blank if the Effective Date is N.A.
Amount Blank Not applicable for Stock Dividends.
Other Amount Blank Not applicable for Stock Dividends.
Currency Blank Not applicable for Stock Dividends.
Comment CP_NOTES

If N.A., then Comments is empty.

Record Date Inclusive | True Always set to true.

Processing Mergers
A Merger can be of the form:

e Company A merges with Company B to be Company C.
e Company A and Company B merges to be Company C.

It is assumed that when two Companies become a third company, Bloomberg will send two merger notifications,
one for each company.

Because a new company would not be in the database, it must be manually added.

Merger Workflow
The following Workflow requires the client to create the Merger stock.

e Follow normal CA processing. If the Process Date >= Ex-Date and it is an update then do not apply.

e Add the CA in a Deactivated state and without a To Product. Bloomberg Connect sends an exception should be
sent to the Task station stating:

"Merger: Merger requires adding Merged stock for Calypso for ID <BBG ID>, Stock <Ticker to Stock> , Ex-Date <Eff
Date>, CA ID <Calypso CAID>. Please add this stock and activate CA.
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12 Bloomberg Trade Integration

Bloomberg Trade integration retrieves the trades through a TCP/IP stream coming from the Bloomberg Mainframes
to a server located at each client site. It uses the TCP/IP stream to check for ACKs and NAKs, to ensure that the
information made it safely to Calypso. The Gateway uses TCP/IP to connect to one or more servers as a client.

Calypso supports Bonds Buy/Sell (Trader Ticket *Journal tickets are not supported).

12.1 Setup

12.1.1 Starting the Import Message Engine

You need to add the Bloomberg Import Message engine to the Engine Manager in Web Admin if not already
available.

Create a new engine called BBGTradelmportMessageEngine with class
com.calypso.engine.advice.ImportMessageEngine

The "config" engine parameter is config = BloombergTrade

The BloombergTrade configuration retrieves information from the
“calypso_bloombergtrade config.properties” property file. Its content is described below. The Import
Message engine MUST be configured with that configuration.

The Bloomberg Trade Import Message engine can be started from the Engine Manager in Web Admin.

P Please refer to Calypso Web Admin documentation for complete details.

12.1.2  Setting Bloomberg Properties

The following variables are specified in the “calypso bloombergtrade config.properties” file located in
“<calypso home>/client/resources”:

e |S_USING_HEADER = False — Default. There is no header.

e |IS_USING_TRAILER = False — Default. There is no trailer.

e |S_EXPECTING_ACK = True — Acknowledge the Bloomberg trade only if it has been successfully processed in
Calypso. If not acknowledged, the Bloomberg trade is re-delivered.

e SAVE_TRADE_IN_FILE_PATH = /home/calypsodev/tmp_dir/.../BloombergTrades.txt

e Specifies the file where Bloomberg trades are saved. The file is reset when the Import Message engine is
restarted.

e PORT = XXXX

e Replace XXXX with the TCP/IP port to listen on and receive the Bloomberg trade. Mandatory.

e FIELD_DEFINITION_PATH = /home/calypsodev/tmp dir/../BloombergTradeFields.txt

e A Bloomberg file containing all the fields that will be transmitted by the Bloomberg Trade feed. Mandatory.
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Copy the file “<calypso home>/client/resources/calypso bloombergtrade config.properties”to

“<calypso home>/ tools/calypso-templates/resources”.

You will then need to deploy the files to your applications servers.

P Please refer to the Calypso Installation Guide for details.

Set the following environment properties as applicable using the User Env application:

e BLOOMBERG_DUMMY_BONDCUSIP=BLOOMBERG

e Identifies the default bond product to use if the product cannot be found via CUSIP, ISIN, or BB (Bloomberg
Unique Identifier). If not specified, and a product cannot be identified, an exception is thrown and the
Bloomberg trade is not processed. Mandatory.

e BLOOMBERG_DUMMY_CPTY=BLOOMBERG

e |dentifies the default counterparty for the Calypso trade. If not specified, and a counterparty cannot be
identified, an exception is thrown and the Bloomberg trade is not processed. Mandatory.

¢ BLOOMBERG_DUMMY_BOOK=BLOOMBERG
e I|dentifies the default book for the Calypso trade. If not specified, and a book cannot be identified, an exception

is thrown and the Bloomberg trade is not processed. Mandatory.
12.1.3  Defining Trade Keywords

Trade Keywords are the defaults that map to Bloomberg Fields obtained from Bloomberg Trade file. Users modify
the Trade Keywords as desired using SQL.

Define the following Trade Keywords:

Trade Keyword Description

BB_ACCRUAL Bloomberg accrual amount
BB_BONDFACTOR
BB_COUPON
BB_PRINCIPAL_AMOUNT Bloomberg nominal amount
BB_RECORD_TYPE Identifies the type of transaction (see below)
BB_SEC_IDENTIFIER Identifies the security code
BB_SEC_IDENTIFIER_FLAG Identifies the security code type (see below)
BB_TRANSACTION Bloomberg ticket number
BB_TRANSACTION_ORIGIN Bloomberg original ticket number
BB_YIELD Bloomberg Trade yield amount
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Trade Keyword Description

tradeScheme Identifies the front office system (in this case
Bloomberg)
12.1.4 Record Types

Supported Record Types:

Number Record Description

Type

2 TT Trader ticket/portfolio allocation from block transaction

6 CTT Corrected trader ticket

102 XTT Cancelled trader ticket

202 PCT Past Date Corrected Trade ticket (to be delivered in patch 09)

302 PXT Past Date Cancelled Trade Ticket (to be delivered in patch 09)
Identifier Flags

ID Description

-1 SEC ID NOT AVAILABLE

0 UNKNOWN or USER DEFINED

1 CUSIP WITH CHECK DIGIT **

2 SEDOL2

3 CEDEL

4 AIBD

5 EURO CLEAR NUMBER

6 WPK

7 RGA

8 ISIN

9 EUROCLEAR/CEDEL COMMON CODE

10 VALOREN
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ID Description

N BELGIAN

12 DUTCH

13 DANISH

14 AUSTRIAN

15 LUXEMBOURG
16 MISC. DOMESTIC
17 NORWAY

18 JAPAN

19 SPAIN

20 ITALY

21 SWEDEN

22 JAPANESE COMPANY NUMBER
23 FRENCH

24 CINS

25 SEDOL1

26 SINGAPORE

27 BELGIAN LOAN
28 U.K. EPIC

29 HONG KONG

30 BLOOMBERG IDENTIFIER

12.1.5

Mapping Counterparties

Define a Default Counterparty

The default counterparty is normally automatically created by the database script.

Define a Default Legal Entity with the role, Counterparty, to use when a match is not found between Bloomberg

and Calypso.

August 2024

Revision 68.0 / Approved Page 112 /128
Private and Confidential



Nasdaqg Calypso
I'lNanaq Bloomberg DL Products Integration Guide / Version 12.17.0

al.e al Entity- Version - 1 [70008/rel700-oracle/calypso_user
B y yp:

Utilities
Short Name BLOOMBERG ‘ Stetus Enabled ¥
Full Name | BLOOMBERG Role(s) (CounterParty
Pt =
Courtry NN g )
Inactive As From :User calypso_user F * .
EreredDate | 02070005 || 7aesaem | : (s )
External Ref | © Plasbled Role(s)
r ] Financial
el | E] O Non Financial
Comment

To establish a mapping on the counterparty, Calypso first attempts to match the Bloomberg Broker to the Calypso
Legal Entity using the short name.

Mapping the Counterparty using the Legal Entity Short Name
E Legal Entity- Version - 0 [70008/rel700-oracle/calypso_user] g@®'
Utilities
Short Name | CT | Stetus Enabied 5
| Role(s) [CounterParty

Inactive As From |User | calypso_user

Entered Date | 0200812005 [72018m | =)
External Ref ] Rizsied Nowets)
r ® Financial
* | C] O Non Financial
Comment

Mapping Counterparties Using the BB_ACCOUNT_SHORT_NAME Legal Entity Attribute

Alternatively, the mapping can be done by populating the Calypso Legal Entity Attribute with the corresponding
Account short name from Bloomberg.

12.1.6  Mapping the Book

Defining the Default Book

The Default Book is used when a matching book is not found between Bloomberg and Calypso.
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¥ Book Window - Version -0 [70008/rel700-oracle/calypso_user]

View
Book Id i-»"'m ‘Aﬂributes C]
Name |BLOOMBERG | [Name Value
Accounting Intent
Activity |BLOOMBERG | Iaciivity
EE_TRADER_PORTFOLIO
Accounting Book TRADING1 v | Defautt GSCC Book
e — EODWeek
Legal Entity | BRANCHE! ) CProfta
[ SUB Profit Center
Location  |GMT v‘
End Of Day [ 23 | Hour 59]Min ]
Base Ccy ‘USD v‘
Holidays ]

Mapping the Book Using the Book Name

To establish a Book mapping, Calypso first attempts to map the Bloomberg Trader Portfolio to the Calypso Short
Name:

W Book Window - Version -0 [70008/rel700-oracle/calypso_user]

View
Bookld | 201 attrites [ .. |
Name | CY DEM Name Walue ]
[ 0, Accounting Intent
Activity | TESTING | [acitiviy
BE_TRADER_PORTFOLIO
Accounting Book | TRADING1 V‘ Default GSCC Book
—_————————— EODWeek
Legal Entity | BRANCHE! IB ProfitCenter CProfita,
| SUB Profit Center
Location [GMT v‘
End Of Day l 23‘Hour 59]Min E
Base Ccy ‘uso v‘
Holidays ]

Mapping the Book Using a Book Attribute: BB_TRADER_PORTFOLIO
Alternatively, you can define a new Book attribute type BB_.TRADER_PORTFOLIO.
This attribute can be used to map the value in Bloomberg to a book in Calypso.

If a mapping is not found, the system uses the default specified in the properties:

= Book Attributes Dialog E]

f&ccouming Intent
[EE_TRADER_PORTFOLIO G
Book Attribute Desk
-» |[EODWeek
ProfitCenter
R ‘SUB Profit Center
Apply ] [ Cancel ]
Aftribute Domain
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¥ Book Window - Version -0 [70008/rel700-oracle/calypso_user]

View
Bookld | 2501 attributes . |
ame | CY TEST Name Value
= *ﬁ Accourting Intent
Activity | TESTING ] Acttivity
BE_TRADER_PORTFOLIO
Accounting Book lTRADING1 v | |Default GSCC Book
—_— EODWeek
Legal Entity | BRANCHE! |[3
SUB Profit Center
Location ‘GMT v‘
End Of Day l 23 ‘Hour 59 ]Min [l
Base Ccy lUSD v ‘
e

12.1.7  Create Default Values
Create a dummy bond as defined in the BLOOMBERG_DUMMY_BONDCUSIP property.

The dummy bond is used when the security code provided by Bloomberg is not found in the Calypso s (i.e., CUSIP,
ISIN, BB_UNIQUE):

Z Bond Window
MNatne |BLOOMBERG | |UST v |D Product Id 9901

Security Code |CUSIP hd | | | ’ Load ] [ Templates .. ]
| Primary Market | Legal Entities | Convertible | call Schedule | Bracy Schedule | Credit Events |
| Biond | Coupan ( Market I Special [ CashFlow
Bond Class |B°f"d b ‘ Band Type |Generic: v ‘
lssue Date Diated Date Maturity Date fssuer | USGVT L]

S Governmerit
Country |L|NI~(NOWT-J OR UNSPECIFIE... |

| 0101 /2000 || 01,401 72000 | | 010142100 ”DD w |

lssue Price Currency Redem. Price Reddatn. Curr. Tatal lzsued Face Value
| 100 |usp v 100 | |usp | 100,000,000 | | 1,000 |
Code |CUSIP V| | BLOOMBERG | Codes ...
Cormrmet Wi, Purchase At

o]

P Code Window BondBLOOMBERG. ..

Product Code Name “alue
CUsIp BLOOMBERG | ~
Feed - Bloomberyg | =
STATUS * YVERIFIED
BE
BE_UHIQUE
CALC_TYP o
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12.1.8 Trade Workflow
The “RequestBloomberg” rule sends a security creation request directly to the Datalicense.

If the Security Code on the trade equals the code defined in the Calypso BLOOMBERG_DUMMY_BONDCUSIP
environment variable, a request is sent to the Datalicense for the “real” security. The real security is identified by
trade keywords specified by the user. By default, they are BB_SEC_IDENTIFIER and BB_SEC_IDENTIFIER_FLAG.

Upon reception of the .out file from the DataLicense the security is created.
The dummy bond used to save the trade is then replaced by the newly created bond.

» Add the RequestBloomberg rule to the “workflowRuleTrade” domain:

Ul Domain Yalues Window
Search: | trade Find | [ ] vaie :

# Iy VolSurface.gensimple ~

| Name: | workflowRuleTrade
# I volSurfaceGenerator — =
1

+ I volSurfaceType

# ity WebFXServerConfig.PropertyName
# {th workflowRuleLegalEntity

# (i workflowRuleMessage

= ) workflowRuleTrade

Value: | RequestBloomberg

Comment:

B rouosibioombers| [_sove pbove ]
& AutomaticFees
2 BrokerFees -
» Add the rule RequestBloomberg to your trade workflow, i.e.:
= WorkFlow Action E]@fz]
| 2202 ‘ Action | AUTHORIZE C]
Orig Stetus | PENDING il Resut Stetus | REVIEW [.]
Evert Class | PSEventTrade \ Subtype irALL i
Product :ALL ‘ Processing Org EALL
[ Ditferent User [[] create Task Use STP Use KickOffACut Off
[[] Log Completed [[] preterred Action [[] updiate Only [ Latest
s | emostuambers [
Fitter [ ] [ Custom Rules Definition ]
Comment

» Add the Kickoff so that rule RequestBloomberg is scanned every 1 minute. When adding a Kickoff (use
kickoff/cut off) to the Pending\Authorize\Review Transition, you must also add the CheckKickOff trade rule.

aKitkﬂHCmOM Config Window [72000/generalprop-Sybase/calypse_user]
= 1 Workfows 4

Eat | Browse

© __|PSEvertmessage ¥

= I PsEventTrace
Worktiow

= Sipom [
S lProdstAuL Recewver {ah Matrod ALL v
L RSuttype- ALL

# I PSEvertTranster Currency ANY v Dats Caicuistor  NONE v
SO Fiter D " -
Date Roll NO_CHANGE v HckOft DaysLeg 0 HckOtf Tere 0 10
Hokdays le) (N0 cutont
TeooZonn Ammricatiew_York )4 CuOftDaysteg |0 CuOtt Temn |23 1|59

(7] Check Hosday

8] Scon Froguercy | 0 i
Absobte Time

[ hew ][ peete ][ save | [ saveasnew |

kO I Wrkfiow B3
2204 2205/

Workfiow Description Feceiver Curency Method KikSOfflag  Kicks
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»  Configuring the Task Station
Add the following exception types to the domain “exceptionType”:

- BB_TRADE_EXCEPTION
- BB_TRADE_INFORMATION

Configure the Task Station accordingly:

12.2 Example — New Trade: US Treasury Note

Trade:

e BUY

e TRADE DATE = 20050106

e SETTLE DATE = 20050107

e PRICE =101

e CTP = ABN AMRO

e BBBOOK = CY_TEST

e CUSIP =912810DX3 T 7 1/2 11/15/16

B 1ask Station/calypso_user/CalypioUiserBloomberg
Corbigurs Aogly Qohus Priocky Action lrepect Lkikes fied

From | OVNI0005 | Bverd Coes Tiade vl W Local fter Norm ol
To | OINTO005 | T Zoon  Amsvicabrtren v [ e [ mocess | [_Free [ PassOver | [_compne ]

: Trackys [1] | Messagns | Paymerts | Exceptorss » v
Edernal Ret Tradekd  Task M Yook Stsbus  Tosk Oramer Comment. Excogtion Type Priceky . User Commert. Dote 4 Teno TRADE _KEY\
Quny | swn| arenziews 1 [Successiuly Ceated Cafypeo trade Sor Bomberg ansaction K = 05217 EX_BB_TRADE INORMATION NOKMAL [1n708 11:91.99.531 PMEST 912810003

No exceptions were generated for this trade which means that the Settlement Amounts and the Yield comparison
between Bloomberg and Calypso matched.

B BondT) 7 142 1171511 6/30Y411715/2016/7.5% -PO is 5G New York (3901) - Version : O Mod User : (calypso_user... [= |[E[X]
Trade Back Office Bond CashFlows Analytics  Pricing Env - Market Data  Utilities

| Tracke: | Distsils | Cashflows | Feas |

rTrade Detail

CUSIP v Im Z100KE (BondT 7 12 1 ASABRIYATHSR0ET 5%) |
Horinal | 130000000 | [usD | clean Prics Setle Dete | 010772005 [_show |

| Proceed Price Detail
Principal 1,/313,000.00 ( Clean Price 101-00 Market Quote 00-00 Iext Coupan 051 6/2005

7.37024191 > I:I Accrual Days

Dirty Price

t

CourterParty | [aBmNY | ] #Bn avro Banicy 14 | 3801
Cv_DEMO v Trade Dte | 0 MBZ005 Status | VERFIED

rAdditional

Mirrar Book MOME s Market Type [NOME b

Comnment | TESTA
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B Keyword Window
Mame Walue
BE_ACCRUAL 1427486 -~
BE_PRIMCIPAL_AMOUNT 1,313,000 T
BE_RECORD_TYPE 2
BE_SEC_IDEMTIFIER 91281003 B
BE_SEC_IDEMTIFIER_FLAG 1
BE_TRANSACTICON 206217
BE_TRANSACTION_CRIGIM 0
BE_*IELD 75370242
tradeScheme ELOCMEBERG
26T A
AllocatedFrom
CAReference w

If a mismatch is found on a received trade’s Settlement Amount or Yield, the following exception messages are
displayed on the Task Station:

B Task Station/calypso_user/CalyproliserBloomberg

Conbigure ogly ks Priocky  Actce lepet  Uklkes Fiod
From | OIN005  Fverd Caes Tiade VW Local fRer Norm ¥[]
To | OINBG005 TewnZone  AmsicaMortied v Load [ process [ e ] [ passowe | [ cCompne |

Tk 1] Messngns | Rayerts | Excaptiorns »
ExdernalRel Tradeld Tashd) Tack Salus Tosh Orer. . Commerd

Excepton Type Pricety U]
ez | w08 arewopew 1 ) ~ 3 Tor Gt . w2 = - - EX_BB_TRALE DFORMATION NORWAL |
206723 | 3808 J7etIpew 2 hows. m Viekd 0f 0 03743478 choms. rt midch the st cakcadated by cabpea 0 08385821 X BB TRADE EXCEPTION  NORMAL |
206222 1305 a7etinew 27 has o precpal amourt of 1,504,700 43 dors ncd match o amourt cakuated try calypeso 1,504,700 94 & _EB TRATE EXCEPTION _ NORMAL |
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13 Bloomberg/Calypso Data Mapping Reference

Use the tables in this section as a reference while you setup the Bloomberg/Calypso mapping for Bond products.

13.1 Bond Tab

The Exception column provides the behavior when the Bloomberg value is missing.
The Default column provides the default value if the Bloomberg value is missing.

For all these fields, on the creation of the security, an exception is created if the column is not in the .out file, the
template value will therefore be used (this should never happen though).

When modifying an existing security, no exception is generated if a column is missing.

Calypso Field Exceptionif | Default Value Bloomberg Fields

Empty?
_amortSchedule No N.A. SINK_SCHEDULE, FACTOR_SCHEDULE
_couponSchedule No N.A. STEPUP_CPN,

STEPUP_CPN_SCHEDULE, STEPUP_DT,
MULTI_CPN_SCHEDULE

_poolFactorSchedule No N.A. FLOATER_ACC_SCHEDULE,
MTG_HIST_FACT

_schedule No N.A. PUT_SCHEDULE, CALL_SCHEDULE

_accrualDaycount Yes ACT/360 DAY_CNT

_announceDate No N.A. ANNOUNCE_DT

_ask No N.A. QUOTE_ASK, PX_ASK,
QUOTE_PRIOR_ASK

_bid No N.A. PX_BID, QUOTE_PRIOR_BID, QUOTE_BID

_callDate No N.A. CALLED_DT

_capStrike No N.A. CPN_CAP, MTG_LIFE_CAP

_Close No N.A. QUOTE_PRIOR_MID,
MTG_PREPAY_SPEED, QUOTE_MID,
PX_LAST

_collateralType No N.A. COLLAT_TYP, INDUSTRY_GROUP

_comment No N.A. DES_NOTES
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Calypso Field

_compoundMethod
_country
_coupon

_couponCurrency

_couponFrequency

_couponOffset
_couponPeriodRule
_currency

_date

_datedDate

_dateRoll
_daycount

_exdividendDays

_faceValue

_firstCouponDate

_floaterB

_floorStrike

_compoundFrequency

Exceptionif
Empty?

No
No
Yes
No
No
If no ZC,
only
No
Yes
No
No

No

Yes
Yes

Only for Non
Mtge

(second
column

must stay
empty)

No

No

No

‘ Default Value ‘ Bloomberg Fields

None
NoCompound
No

N.A.

CRNCY
Column

SA

N.A.
UNADJUSTED
N.A.
N.A.

ISSUE_DT Col-

umn if
INT_ACC_DT

Empty
FOLLOWING
ACT/360

0

1000

N.A.

N.A.

N.A.

CMPD_FREQ_CNV_YLD, REFIX_FREQ
CMPD_FREQ_CNV_YLD
COUNTRY_ISO, CNTRY_ISSUE_ISO
CPN

CPN_CRNCY

CPN_FREQ

MTG_PAY_DELAY
FLT_CPN_CONVENTION, DAY_CNT
CRNCY

LAST_UPDATE_DT, PX_DT_1D

INT_ACC_DT, ISSUE_DT

DAY_CNT
DAY_CNT

EX_DIV_DAYS

PAR_AMT

FIRST_CPN_DT

MTG_LIFE_FLOOR, CPN_CAP,
MTG_LIFE_CAP, CPN_FLOOR

MTG_LIFE_FLOOR, CPN_FLOOR
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Calypso Field

_holidays

_issueDate
_issuePrice
_issuerld
_maturityDate
_maturityTenor
_minPurchaseAmt
_name

_optionType

_penultimateCouponDate
_poolFactorType
_quoteType

_ratelndex
_ratelndexSpread

_redemCurrency

_redemptionPrice

_rollingDay

_tickSize

_totallssued

_withholdingTax

_yieldMethod

Exceptionif
Empty?

Yes

No
Yes
Yes
No
No
No
No

No

No
No
No
No
No

No

Yes

No

Yes

Yes

No

Yes

‘ Default Value ‘ Bloomberg Fields

Currency
Holidays

N.A.
100
BLOOMBERG
N.A.
N.A.
N.A.
N.A.

N.A.

N.A.
N.A.
N.A.
N.A.
N.A.

CRNCY
Column

100

N.A.

100

1000000

ISMA

CALENDAR_CODE

ISSUE_DT

ISSUE_PX

ISSUER

MATURITY

MATURITY, ISSUE_DATE
MIN_INCREMENT
TICKER, SECURITY_DES

MTG_LIFE_FLOOR, CPN_CAP,
MTG_LIFE_CAP, CPN_FLOOR

PENULTIMATE_CPN_DT
SECURITY_TYP2
PX_DIRTY_CLEAN, QUOTE_TYP
RESET_IDX

FLT_SPREAD

REDEMP_CRNCY

REDEMP_VAL

MTG_ACC_RT_START_DT,
CPN_ASOF_DT, DAY_CNT

QT_SPEC

MUNI_ISSUE_SIZE, AMT_ISSUED,
MUNI_MTY_SIZE, PAR_LAMT

WITHHOLDING_TAX

DAY_CNT, MTG_PREPAY_TYP
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Calypso Field Exceptionif | Default Value Bloomberg Fields
Empty?
CODE#BB_UNIQUE No N.A. ID_BB_UNIQUE
CODE#CUSIP No N.A. ID_CUSIP
CODE#ISIN No N.A. ID_ISIN
CODE#DTC No N.A. DTC_ELIGIBLE
Bond Class and Subtype

The basic information is contained in the following fields, however additional logic is required as the mapping may
differ by bond market sector. The mapping is therefore not 1:1.

Calypso Field Bloomberg Field Comments

Issue Date ISSUE_DT

Dated Date SETTLE_DT

Maturity Date MATURITY

Issuer Issuer The issuer information is created or mapped using the

<NAME> or <TICKER>.

Country CNTRY_ISSUE_ISO This is the Standard ISO codification on two characters.

Map the two ISO characters against the Calypso country
name.

[NOTE: BLOOMBERG uses non-standard ISO codes
(i.e., SNAT).]

Define ZZ code in the Bond Template UNKNOWN OR
UNSPECIFIED COUNTRY.

Issue Price ISSUE_PX
Currency CRNCY
Redem. Price REDEMP_VAL
Redem Curr REDEMP_CRNCY RULE if no values are provided use CRNCY.
Total Issued AMT_ISSUED RULE For Govt and Corp only.
MUNI_MTY_SIZE RULE For Muni type only.
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Calypso Field

Face Value

Codes

Min Purchase

Bloomberg Field
PAR_AMT

TICKER
ID_ISIN
ID_CUSIP
ID_BB

MIN_INCREMENT

Comments

RULE Override this value and replacing it by 1.

Allow a parameter to override the value provided by this
field and to change it to 1.

See Bloomberg Mapping values for all sec codes.
See Bloomberg Mapping values for all sec codes.
See Bloomberg Mapping values for all sec codes.
See Bloomberg Mapping values for all sec codes.

This value is not currently used on the Bond Definition

Amount For mtg: x:ggga but internal rules could be developed on the Trade
MTG_MIN_ACREMENT ‘
13.2 Coupon Panel
Coupon Data
Calypso Field Bloomberg Field Comments
Fixed Rate CPN_TYPE FIXED: FIXED, FIXED, OID, ZERO COUPON, NONE.
FLOATING: ADJUSTABLE, DEFAULTED, FLOATING INTER
APPRECI, STEP CPN, VARIABLE.
Floating Rate
Rate CPN
Daycount DAY_CNT_DES RULE
Ccy CPN_CRNCY RULE if no values are provided use CRNCY.
Holidays CALENDAR_CODE Mapping

Corp Bonds
MARKET_SECTOR_DESC=C
orp

FLT_PAY_FLOAT_CALENDA
R

Mortgage Backed Bonds

MARKET_SECTOR_DESC=M
tge

If unmapped, will populate based on the combination of the
holiday calendars from the Currency Default and Country
Code.
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Calypso Field

Roll Date
Payment Lag
Payment Rule
Date Roll

Frequency

Coupon Digits
Acc Daycount
Stub Start

Stub End

Reset Frequency

Reset Holidays

Bloomberg Field
MTG_CALENDAR_CODE

CPN_FREQ

FIRST_CPN_DT

Corp Bonds
MARKET_SECTOR_DESC=C
orp

FLT_REFIX_HOLIDAY_CDR
Mortgage Backed Bonds

MARKET_SECTOR_DESC=M
tge

RATEDET_CALENDAR

Comments

No mapping field in Bloomberg. No Default Value.
Mapping

RULE

RULE

RULE

If ZERO_CPN =Y Then Frequency ZC
Else FREQUENCY CPN_FREQ
ANNUAL 1

SEMI_ANNUAL 2

QUARTERLY 4

BMONTHLY 6

mapping 12

No mapping field in Bloomberg. Set Parameter.

RULE

No mapping field in Bloomberg.
No mapping field in Bloomberg.

If unmapped, will populate based on Rate Index Definition
Reset Hol field.
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13.3

Calypso Field

Settle Days
Accrual Days
Ex-Dividend

Bus

Accrual Dig.
Nearest, UP, Down
Price Dec

Yield Dec.

Market Panel

Bloomberg Field

8
Nearest
8

8

Comments

template

template

template
template
template

template

Announce Date

ANNOUNCE_DT

Auction Date
Default Date

Tick Size

Yield Method

Quote type

Withholding Tax

Issue Paying Agent

QT_SPEC

WITHHOLDING_TAX

No mapping field in Bloomberg.
No mapping field in Bloomberg.

Ensure all the required values are defined in
Domain Value > Tick Size

e 8

e 16
o 32
o 064
e 100
e 128
e 200
e 256
o 512

ISMA MM_ACT360 MM_ACT365 USSSTREET PSA
CPR

QUOTE_TYP2Discount Quoted QUOTE_TYP1Price
Quoted QUOTE_TYP3Yield Quoted

No mapping field in Bloomberg.
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Calypso Field Bloomberg Field Comments

Calculator Agent No mapping field in Bloomberg.
Trustee No mapping field in Bloomberg.
Benchmark No mapping field in Bloomberg.
Commission Paid No mapping field in Bloomberg.

13.3.1  ABS Panel

Calypso Field Bloomberg Field Comments

Coupon MTG_HIST_CPN

For Mortgage Backed Securities, Bloomberg has the following codes:

e MTG_PREPAY_TYP — Prepayment Type Values = ABS PSA CPR CPJ CPY BAM

¢ MPR — Monthly Payment Rate. Principal plus finance charges plus fees collected divided by the current
month's beginning pool principal balance. Applies to Credit card securities.

o CPJ—"CPJ"is Bloomberg's prepayment rate notation which is exactly like CPR, except that it also
incorporates DLJ’s Project Loan Default (PLD) model for involuntary prepayments — similar to defaults with
100% recovery. This concept is most commonly used within CMBS (Commercial MBS) structures.

For example, 10 CPJ is 10% CPR for voluntary prepayments plus 100% of the base PLD curve rate for
involuntary prepayments.

e CPY —"CPY”is Bloomberg's prepayment rate notation which is exactly like CPR, except that prepayments are
assumed to be 0% until the expiration of yield maintenance provisions. This concept is most commonly used
within CMBS (Commercial MBS) structures. For example, 10 CPY is 0% CPR followed by 10%.

e ABS — ABS (Absolute Prepayment Rate). The standard measure of prepayments for automobile loan backed
securities. ABS calculates prepayments as the percent of original dollar balance of receivables.

¢ BAM —"BAM” is Bloomberg Agency Model. This model projects the prepayment behavior of loans backing
agency pools. The model uses “base” models for the most common types of loans and sub types of the “base”
model for smaller loan programs. The model produces a vector of prepayment rates (CPRs SMMs) based on
collateral characteristics and market environment. BAM is commonly used for agency Pools and CMOs.

13.3.2  Equity Mapping

Bloomberg Field Calypso Value

NAME Corporate Name
CNTRY_ISSUE_ISO Country
ISSUER ISSUER
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Bloomberg Field Calypso Value

INDUSTRY_SECTOR
CRNCY

CPN_CRNCY
REDEMP_CRNCY
ID_MIC_PRIM_EXCH
EQY_PRIM_EXCH_SHRT
EXCH_CODE
EQY_SH_OUT_ACTUAL
TOT_SHRHLDR_EQY

DVD_CRNCY

Issuer LE INDUSTRY attribute

Currency and Quote Type

Exchange

Total Issued

Dividend currency

EQY_DVD_SH_LAST
EQY_DVD_FREQ
DVD_DECLARED_DT
DVD_RECORD_DT
DVD_PAY_DT
DVD_EX_DT
DES_NOTES
PX_TRADE_LOT_SIZE
SECURITY_TYP2
QT_SPEC
QUOTE_ASK
QUOTE_BID
PX_OPEN

PX_LOW

Dividend amount
Dividend Frequency
Dividend Declared Date
Dividend Record Date
Dividend Payment Date
Dividend Ex Date
Comment

Trading Size

Sub Type

_tickSize

Ask Quote

Bid Quote

Open Quote

Low Quote
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Bloomberg Field Calypso Value

PX_HIGH High Quote
PX_LAST Last Quote
PRIOR_CLOSE_MID Close Quote
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